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Preface 
 

Southern Cross Software Solutions 
Southern Cross Softw are Solutions (SCSS) is a 
softw are development/consultancy business 
based in Perth, Western Australia, Australia.   
SCSS has experience in the follow ing areas: 

•  C++ and Java application development. 
•  Websites developed using the latest XHTML, Perl CGI scripts, JavaScript, 

and Java technologies, particularly using the Apache w eb server. 
•  Developing softw are for the Psion series of handheld computers. 
•  Developing softw are for the Unidata range of data loggers. 

Southern Cross Softw are Solutions 
46 Griffell Way 
Duncraig WA 6023 
Australia 
Web: http://w w w .scsoftw are.com.au/ 

ABN: 70 694 305 679 
Tel: +61 8 9246 5485 

Fax: +61 8 9246 2972 
Email: sales@scsoftw are.com.au 

Support: support@scsoftw are.com.au 
 

Unidata Australia Pty Ltd 
Unidata Australia Pty Ltd is an Australian company 
specialising in the manufacture of electronic data loggers 
and related environmental monitoring equipment and is 
part of the global Unidata Group. 
Tailored to operate in remote areas, their equipment is designed to be battery pow ered 
(w ith solar pow er options), often for up to one or tw o years.   Unidata also 
manufacture various sensors for measuring temperature, humidity, rainfall, w ater flow , 
w ater depth, evaporation, solar radiation, w ater conductivity, w ater turbidity, dissolved 
oxygen, w ater acidity, w ind speed, w ind direction, barometric pressure, soil moisture, 
and others. 
Unidata have no connection w ith PsiLog apart from being the manufacturer of the 
equipment w ith w hich PsiLog is designed to w ork.   Please contact Southern Cross 
Softw are Solutions for any queries you may have regarding PsiLog. 

Unidata Australia 
40 Ladner Street 
O’Connor WA 6163 
Australia 
Web: http://w w w .unidata.com.au/ 

 
Tel: +61 8 9331 8600 

Fax: +61 8 9331 8611 
Email: sales@unidata.com.au 
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Overview of PsiLog 

 
The PsiLog softw are package allow s the unloading, programming and testing of 
Unidata loggers on site via Psion handheld computers. It is an easy to use package that 
is compatible w ith your existing Starlog softw are system and provides robust and 
reliable support of your dataloggers w hile in the field.   It does not replace the Unidata 
Starlog softw are that needs to be installed on your PC for PsiLog to function. 

Items supplied 

Items supplied w ith PsiLog are: 

• User Guide (this book). 
• A floppy disk or CD w ith the PsiLog softw are and electronic copy of this User 
Guide. 

• A registration card. 

Requirements 

PsiLog requires: 

• A PC computer w ith a 3½” floppy disk drive and running Window s 95, 98, NT 
4.x, ME, 2000 or XP. 

• 1.4MB of storage space on your PC computer. 
• An RS-232 serial communications port on your PC for connecting to the Psion 

computer.   The same port you have been using to communicate w ith your data 
logger w ould be suitable. 

• A Workabout, Workabout mx, Series 3a, Series 3c, Series 3mx, or Siena Psion 
computer.   Southern Cross Softw are Solutions is an authorised reseller of the 
Psion Workabout computer. 

• An RS-232 serial communications port on the Psion for connecting to Unidata 
data loggers and to your PC.   Unidata Model 6003 data loggers w ill require a 
Model 6800 Level Converter that is available from Unidata. 

• Serial cables for connecting your Psion to your PC, and your Psion to your data 
loggers.   See Serial connections on page 9.   Southern Cross Softw are Solutions can 
supply appropriate cables on request. 

• 194K of storage space in the Psion for PsiLog program files.   This can be on the 
internal RAM disk or on Flash/RAM SSDs. 

• 70K additional RAM memory on the Psion to run PsiLog. 
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• Familiarity w ith the procedures and terms used by the Unidata Starlog softw are 
package. 

In addition, PsiLog w ill require storage space for: 

• Previously created scheme files required to program data loggers. 
• Data unloaded from data loggers. 
• Test display screens. 
• Formulas. 

These files may be located on the internal RAM disk or on Flash/RAM SSDs. 

Data unloaded from data loggers may consume considerable space – a large capacity 
Flash SSD is recommended.   Sizes up to 8MB are available. 
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The Workabout computer 
The Psion Workabout (show n on the right) is a handheld industrial 
computer manufactured by the Psion Teklogix division of Psion Plc, 
a UK based company.   It is tough and w eather-resistant, as are the 
Unidata data loggers w ith w hich PsiLog is designed to w ork. 

Each Workabout comes w ith 2MB of memory as standard, enough 
to unload 13 full Starloggers!   The memory can be expanded by a 
further 16MB. 

Workabout computers can come in many different configurations.   
PsiLog requires that the Workabout have at least one RS-232 level 
serial port.   Depending on the model of the Workabout, the port 
can be located at the top or the bottom of the computer.   In either case, there w ill be 
a small label near the port that reads “RS232”.   For example, the picture below  shows 
the top of a Workabout, w ith the RS-232 port to the right.   The port on the left is a 
TTL-level port, and is not used by PsiLog. 

On all Workabout computers sold by 
Southern Cross Softw are Solutions, the 
RS-232 port is the “A” port, and by 
default that is the port that PsiLog w ill 
use. 

The port is a “DB9 male” connector, and 
is functionally identical to the DB9 serial 
port on your desktop or laptop PC. 

The Keyboard 
The Workabout keyboard is an alpha-numeric style, there being not enough space for a 
conventional QWERTY-style keyboard. 

The keys all w ork as expected, most parallel those found on a regular computer 
keyboard.   Some of the keys are unique to the Workabout or have special uses.   They 
are explained below : 

 

Turns the Workabout on, and doubles as the Escape key.   As usual on 
PCs, the Escape key is used to cancel dialog boxes. 

Shift-Esc displays the online help. 

 

The same as the Tab key on a PC.   The Workabout uses the Tab key 
to expand choice lists in dialog boxes for easier selection, and to open 
sub-dialog boxes w ith extra options. 
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The Menu key displays the application’s menus.   To make the most of 
the limited screen space, menus are hidden until they are needed. 

The combination Psion-Menu temporarily displays the full-size status 
bar.   Ctrl-Menu changes the permanent status bar betw een off, half-
w idth and full-w idth. 

 

The Contrast key.   Press to increase the screen contrast.   Hold 
dow n the Shift key and press to decrease the contrast.   The 
Workabout has a temperature compensating display and the contrast 
w ill need only minor (if any) changes w hen moving betw een an air-
conditioned office or car and the outdoors. 

 
The Backlight key.   Press to toggle the screen backlight on and off. 

 

Turns the Workabout off.   The Workabout may be sw itched off at any 
time w ithout loss of data.   Turn the Workabout back on and everything 
w ill be as it w as before it w as turned off.   The Workabout does not 
have a ‘shutdow n’ procedure, and in fact it is not expected to ever need 
to be reset. 

 

Deletes the character to the left of the cursor, the same as the 
Backspace key on PCs.   If the Shift key is held dow n it deletes 
the character to the right of the cursor, the same as the Delete key on 
PCs. 

 
The same as the Enter key on PCs.   It is the key used to accept menu 
selections and to OK dialog boxes. 

 

The Psion key.   This corresponds to the Alt key on PCs.   Holding 
this key dow n at the same time as pressing a letter key activates many 
functions.   Some functions require the Shift key to be held dow n as 
w ell. 

Special Key Combinations 
The Psion key has many special combinations.   Some of the more important ones 
are outlined below : 

Psion-Up Arrow The Page Up (PgUp) key. 

Psion-Down Arrow The Page Dow n (PgDn) key. 

Psion-Left Arrow The Home key. 

Psion-Right Arrow The End key. 
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Psion-Menu Temporarily displays the full-size status bar.   Has no 
effect if the full-size status bar is already visible. 

Psion-Space Toggles Caps Lock. 

Psion-Ctrl-Shift-K Kills (exits) the currently running program w ithout 
saving any data. 

Psion-Ctrl-Del Soft reset.   Exits all running programs (w ithout 
them saving any data) and restarts the Workabout 
without clearing the Internal RAM disk. 

Psion-Ctrl-Shift-Del Hard reset.   Clears all memory.   This includes all 
running programs and the entire Internal RAM disk. 

The Psion and Ctrl keys have a coloured line above them.   Other keys have a 
similarly coloured character or function above them.   Pressing the Psion or Ctrl 
key at the same time as pressing one of these labelled keys, w ill result in the 
corresponding character or function being pressed. 

For example, the English language (UK model) Workabout has a yellow  line above the 
Psion key.   The 8 and 9 keys have yellow  square brackets ([ and ] respectively).   
Pressing Psion-8 w ill cause the [ character to be entered, Psion-9 the ] 
character. 

Battery Status 
The Workabout is able to display the state of its batteries at all times.   Press 
Ctrl-Shift-B at any time to display the Pow er Supply Info dialog: 

 
 

 

 

 



PsiLog  9 

Serial connections 
To connect the Workabout computer to your data loggers, you need the same cable as 
used to connect your PC to your data loggers. 

Connecting to Starloggers 
To connect to Starlogger-type data loggers that 
have a “DB25 female” connector, you w ill need 
to use a cable that looks like the one to the 
right. 

 

 

Connecting to Starflows 
To connect to Starflow -type data loggers 
that have a “DB9 female” connector, you 
w ill need to use a cable that looks like the 
one to the right. 

This type of cable is also know n as a “serial 
extension cable”, “mouse extension cable” 
or “CGA/EGA video extension cable”. 

Connecting to various data loggers 
If you need to connect to a mix of data loggers, then 
the best solution is to use the cable for connecting to 
Starflow s (“DB9 female” to “DB9 male”), and use a 
“DB9 male” to “DB25 female” adapter to allow  the 
same cable to connect to your Starlogger-type data 
loggers.   Such an adapter is show n to the right. 

Simply use the cable by itself to connect to Starflow s, 
then plug on the adapter to connect to Starloggers. 
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Starlogger speed switch 
While Starflow -type loggers are able to have their baud rate 
set via a firmw are configuration option, Starlogger-type 
loggers require that their baud rates be set in hardw are, by 
connecting specific pins on their Computer connector 
together. 

The SCSS Speed Sw itch is a simple adapter that allow s you 
to easily select the fastest baud rate supported by both your 
Psion computer and your data logger(s).   Obviously, the 
faster the baud rate, the faster you can do an unload and 
move on. 

Set the sw itch to 19200 for non-mx Workabout computers and to 38400 for 
Workabout-mx computers.   Remember to configure PsiLog to use the same baud 
rate.   See Communications preferences on page 41. 

The sw itch must plug directly into the Starlogger Computer connector; the serial cable 
from the Workabout then plugs into the sw itch. 

Connecting to your PC 
To connect to your PC, you need to use a “null 
modem” or “laplink” serial cable.   It is the 
same cable you w ould use to connect tw o 
desktop/laptop computers together. 

A suitable cable is show n to the right.   Each 
end has both “DB25 female” and “DB9 
female” connectors, allow ing it to w ork w ith 
either type of connector your desktop PC may 
have.   The Workabout w ill alw ays use the 
“DB9 female” connector at the other end. 

Note that you cannot use the tw o connectors at the same end of the cable 
simultaneously. 

Setting up the Workabout 

When programming data loggers, the date/time of your Psion computer is used 
to set the date/time of the logger.   Make sure your Psion computer is set to the 
correct date/time before programming any data loggers.   See below  for more 
information 

 

����
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If you purchased your Workabout computer from Southern Cross Softw are Solutions, 
then it w ill have already been set up, w ith the date/time set and PsiLog installed and 
configured.   How ever, if the Workabout ever completely loses pow er (for example, if 
you remove both the main and backup batteries at the same time) or resets in some 
other fashion, then you w ill have to re-configure its settings yourself. 

When the Workabout is sw itched on for the first time, you w ill see the follow ing 
screen: 

 
Press the Menu key then use the arrow  keys to select System screen and press 
Enter: 

 
The System program w ill appear: 

 
Select System Configuration from the Ctrl menu: 
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Select Time and date format from the System formats menu: 

 
Change the settings to w hat you w ant, but Southern Cross Softw are Solutions 
recommends changing the Time format to “24 hour” as that is the convention 
used by Unidata data loggers and the Unidata Starlog softw are. 

 
Press Enter to accept the settings.   Next, select Set time and date from the 
Ctrl menu: 

 
Enter the GMT Offset first and then set the correct local Time and Date.   
Setting the time on your Psion computer is very important as w hen data loggers are 
programmed, their internal clocks are set to the same time as your Psion. 

 
Press Enter to accept the time and date settings.   You have now  finished setting up 
your Psion computer and can proceed w ith installing PsiLog.   Remember that w hen 
the PsiLog installation instructions ask you to go to the System screen to start the 
remote link, you are already there! 
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Other Psion computers 
PsiLog is not limited to the Workabout series of Psion 
computers.   It also w orks w ith the Psion Series 3a, 3c, 
3mx, and Siena computers.   How ever, the serial interfaces 
of these computers are designed to connect directly to 
your desktop PC, and not to data loggers! 

To connect them to data loggers, you w ill need a null-
modem device and some gender changers.   The Series 3a 
w ill also need its 3-Link RS232 Serial Interface.   
Depending on the data loggers, cables, and null-modem 
device, you may also need some DB9-DB25 adapters. 

Southern Cross Softw are Solutions can advise you on how  to connect these Psion 
computers to your data loggers.   When contacting Southern Cross Softw are Solutions, 
please include details of your Psion computer and data loggers. 
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Installing PsiLog 
The main PsiLog program is installed on your Psion.   There is also some Link 
softw are that must be installed on your PC computer.   If your PC computer is 
running Window s 95, 98, ME, NT 4, 2000 or XP, install PsiLog by follow ing the 
instructions below .   If your PC computer is running Window s 3.x or MS-DOS, you 
must contact SCSS directly.   Install files for these operating systems are available via 
email only. 

1. Put the PsiLog installation disk into your PC’s floppy disk drive. 
 

2. Open the Control Panel (Start→Settings→Control Panel): 
 

 
 

3. Open the Add/Remove Programs icon: 
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4. Click on the Install… button: 
 

 
 
If you’re using Window s 2000 or XP it’s a little different.   Click on the 
Add/Remove Programs button on the left and then the CD or 
Floppy button on the right. 
 

5. Click on the Next> button and Window s w ill search for the PsiLog setup 
program.   It should find it on the PsiLog Install disk you inserted: 
 

 
 

6. Click on the Finish button to start the PsiLog install program.   After a 
few  seconds your PC screen should show  the setup w elcome screen: 
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Press Enter or click on Next>. 
 

7. Connect your Psion to your PC using an appropriate serial cable.   If you’re 
not sure how  to do this, see Serial connections on page 9 and Serial communications 
on page 88 for more information. 
 

8. Turn on your Psion and activate its Link.   You w ill need to use the System 
screen to do this.   Select System screen from the Special menu: 
 

 
 
Then select Remote link from the Spec menu: 
 

 
 

9. Set the Remote link to On, the Baud rate to 19200 and the Port 
to A (only Workabout computers have a Port option).   Press Enter to 
activate the Link. 
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10. Go back to your PC and continue the setup there.   The information screen 
show n paraphrases these instructions.   You can read it, but this User Guide 
should provide a clearer explanation.  
 

 
 
Press Enter or click on Next>. 
 

11. You w ill now  be asked for the destination directory: 
 

 
 
It defaults to C:\Program Files\Southern Cross Software 
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Solutions\PsiLog.   If you w ant to install into a different drive or 
directory either type in the new  drive or directory, or use the controls to 
select the drive and directory you w ant.   Otherw ise, just press Enter or 
click on Next> w hen the drive and directory are w hat you w ant.   The setup 
program w ill create the directory for you if it doesn’t already exist. 
 

12. You w ill now  be asked to select w hich components of PsiLog to install: 
 

 
 
The PsiLog Link component is required for PsiLog to be able to transfer files 
to and from your PC.   If you happen to have some other softw are installed, 
such as PsiWin, you can use that instead.   You can still install PsiLog Link, 
though. 
 
The PsiLog User Guide is in Adobe Acrobat PDF format.   To read it you 
must have either the full version of Acrobat installed, or the free Acrobat 
Reader.   Acrobat Reader is too big to fit on the PsiLog floppy disk.   You 
can dow nload it from Adobe’s w ebsite.   The Internet address is: 
http://www.adobe.com/products/acrobat/readstep.html 
 
Make sure the components you w ant to install are ticked, then press Enter 
or click on Next> to continue. 
 

13. You w ill now  be asked to select the Start menu folder for the PsiLog icons: 
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It defaults to Psilog, but if you w ant a different name just type it in.   Press 
Enter or click on Next> to continue. 
 

14. The next installation step lets you create extra icons for starting PsiLog Link.   
If you decided not to install PsiLog Link you w on’t see this screen; skip ahead 
to step 15. 
 

 
 

15. PsiLog is now  ready to install.   Just press Enter or click on Install to 
continue. 
 

16. If you elected to install PsiLog on your Workabout, after installing the PsiLog 
files for your PC the setup program w ill immediately proceed to installing the 
PsiLog files onto your Psion. 
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17. If a connection is established w ith your Psion a message Reading 
device information from the Psion w ill be show n.   You may 
also see a message Copying communication system files to 
the Psion.   Eventually, a w indow  similar to the follow ing w ill appear: 
 

 
 
Proceed to step 18. 
 
If there is a problem communicating w ith your Psion, the follow ing 
w indow  w ill appear. 
 

 
 
Click on Setup.   The follow ing dialog w ill appear: 
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First check the Port setting.   Many computers are configured w ith a serial 
mouse on COM1, so COM2 may need to be selected.   Next, select the 
Baud Rate.   The baud rate suggested above in step 9 w as 19200.   If you 
have one of the Psion computers mentioned on the buttons, press that 
button to select the baud rate.   The ‘Other’ model is suitable for Workabout 
computers.   In all cases the Baud Rate must match that being used by your 
Psion.   Click on OK and then Retry.   The w indow  show n at the beginning 
of this step should appear. 
 
If problems persist, check your cabling and COM port on the PC.   Make 
sure no other Window s programs are running that might be using the COM 
port.   Common programs to check for are Internet diallers and fax systems.   
See also the Troubleshooting starting on page 87. 
 

18. Select the Disk you w ant to install PsiLog to and press OK.   SCSS 
recommends you install PsiLog on the Internal RAM disk.   Make a note of 
the disk you select for later reference.   The follow ing w indow  w ill appear 
show ing the progress of the installation: 
 



22  PsiLog 

 
 

19. When complete, the follow ing w indow  w ill appear: 
 

 
 
Press Enter or click on OK.   The transfer from your PC is complete. 
 

20. You can now  turn off the Link on your Psion.   Select Remote link and 
set it to Off. 
 

 
 

21. PsiLog w ill now  appear under the “Run OPL” icon: 
 

 
 

22. If you are using a non-Workabout Psion computer, you can install 
PsiLog as its ow n icon in the System screen.   Press Psion-I, select the 
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Disk you copied PsiLog to (the disk you selected in step 18), then in the 
Name field type in Psilog and press Enter: 
 

 
 
PsiLog w ill appear as an icon: 
 

 
 

23. Your PC should now  be show ing a Setup Information screen: 
 

 
 
Read the information then click on Next>.   Click on Finish to close the 
PsiLog install program.   The Window s Control Panel w ill still be open.   You 
can close it if you like. 
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How to use the Link software 
You start the PsiLog Link softw are much like any other program on your PC.   Click 
on the Start button, select Programs, the group you selected to install the Link 
softw are into (the default is PsiLog), and then click on “PsiLog Link”. 

 
The Link softw are w ill start running: 

 
It w ill just sit there w aiting for PsiLog on your Psion to connect to it.   Simply make 
sure Port is correct and Baud matches the PsiLog settings under Remote link 
preferences.   Your Psion and your PC w ill have to be connected using a suitable cable. 

The follow ing table covers the status messages you’re most likely to see: 

Status message Description 
Attaching to 
engine 

You may see this message appear briefly w hen starting 
PsiLog Link or w hen disconnecting the cable betw een 
your Psion and your PC. 

COM port in 
use 

Another program is using the serial port.   If the Port 
setting is correct you w ill have to determine w hich 
program is using the serial port and exit it.   You w ill 
then either have to exit and restart PsiLog Link, or click 
on the Setup… button and click OK. 
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Connecting The cable is OK and the COM port is correct, but your 
Psion and your PC are not yet linked together.   You w ill 
see this if you connect your Psion to your PC, but are not 
actually transferring files.   If you attempt to transfer files, 
but still see this message (and the transfer fails), make 
sure you have selected the same baud rate for both 
computers. 

Copying system 
software 

Some files needed by your Psion computer for the Link 
to function are being copied from your PC to your Psion.  
You should only see this the first time you connect your 
Psion to your PC after your Psion w as reset (either 
manually or through lack of pow er). 

Disconnecting You may see this message appear briefly w hen you finish 
a file transfer or disconnect the cable betw een your Psion 
and your PC. 

Failed You may see this message if the COM port settings are 
incorrect, or if there is a communications problem 
betw een your Psion and your PC. 

Linked Your Psion and your PC are connected and transferring 
files. 

No connection There is no physical connection betw een your Psion and 
your PC.   If the tw o computers are connected, it could 
be the cable is faulty, or you have selected the w rong 
COM port. 

When you’ve finished transferring files, simply close PsiLog Link. 

Selecting the Link baud rate 
Ideally, the Baud setting should be the fastest possible.   This depends on tw o things: 
the model of your Psion, and the link server softw are you are using on your PC.   The 
table below  lists the maximum baud rates for Psion and Link softw are packages.   
Look up your Psion and your Link server softw are and use the smaller of the two baud 
rates.   Note that PsiLog comes w ith the PsiLog Link server softw are. 

Psion Link server softw are 
Model Max. baud rate Name Max. baud rate 

Workabout-mx 115200 PsiLog Link 
(This comes with PsiLog) 

57600 

Workabout 19200 Epoc Connect 115200 
Series 3mx 115200 PsiWin v2.x 115200 
Series 3c 57600 PsiWin v1.x 57600 
Series 3a 19200 RCOM 57600 

Siena 19200 MCLINK 19200 
  SLINK 19200 
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If you are unsure, select 19200 baud as all computers and softw are packages w ill work 
at that baud rate.   Make sure your Psion and Link softw are are configured to use the 
same baud rates. 

If you seem to be having trouble getting a connection, try 19200 baud first and 
increasing the baud rate if that w orks, or decreasing it if it doesn’t.   See the 
Troubleshooting section starting on page 87 if you can’t get the Link softw are to w ork. 

Selecting the correct PDL directory 
The PDL directory setting of the Remote link preferences dialog must be set to refer 
to the directory in w hich your Unidata softw are is installed. 

By default, the Unidata Starlog softw are package installs to the C:\STARLOG\ 
directory, the Unidata Starflow  softw are package to C:\STARFLOW\.   During the 
installation of these packages you are given the option of changing these default 
locations.   Whichever package you have, it is critical that PsiLog is set to refer to the 
directory is has been installed to, otherw ise you w on’t be able to transfer schemes to 
the Workabout, nor transfer unloaded data to your PC. 

By default, the PDL directory setting in PsiLog is REM::C:\STARLOG\.   The 
REM:: part is very important as it specifies the Unidata softw are is installed on a 
computer remote from the Workabout.   The C:\STARLOG\ part specifies the 
default directory the Unidata Starlog softw are is installed to on your PC. 

If you are using the Unidata Starflow  softw are package, or you installed your Unidata 
softw are into a directory other than the default, then you must change the PDL 
directory setting to refer to the correct directory on your PC.   Remember to include 
the beginning REM::. 

For example, if you are using the Unidata Starflow  softw are package and installed it to 
the default C:\STARFLOW\ directory, you must set the PDL directory setting to 
REM::C:\STARFLOW\. 
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Running PsiLog for the first time 

Starting PsiLog 
If you have just completed installing PsiLog, you are most likely in the System 
program.   Highlight “Psilog” under the “Run OPL” icon and press Enter: 

 
PsiLog w ill start running. 

If you are at the Workabout startup screen, select System screen from the 
Special menu: 

 
Now  highlight “Psilog” under the “Run OPL” icon and press Enter: 

 
Later on under Customising the Workabout to start PsiLog automatically on page 32, you will 
find out how  to enable PsiLog to start from the Workabout startup screen simply by 
pressing Enter. 

Initial configuration 

The first time PsiLog is run, it uses a default configuration.   For most people this 
configuration is suitable, but others may need to change it. 
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When PsiLog starts it w ill alw ays show  a splash screen.   Press Enter or Esc to clear 
it. 

 

PsiLog has several different screens and w ill normally start show ing w hatever screen it 
w as show ing w hen you last used it.   When PsiLog starts for the first time, it starts in 
the Test Display screen. 

 

Press Menu then use the arrow  keys to select Set preferences under the 
Special menu. 

 

Use the arrow  keys to move to the General menu and select Communications. 
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This dialog show s the communication settings used to communicate w ith your data 
logger.   PsiLog ignores scheme communications settings, so ensure the Port and 
Baud settings are correct.   Press Enter to accept the dialog settings. 

 

Now  press Menu again, select Set preferences then Remote link. 

 

This dialog show s the communication settings used to communicate w ith your PC.   
From your Psion’s point of view , your PC is a remote computer. 

 

If you connect your Psion to your PC via a cable then Port A is most likely the 
correct choice.   If you use a docking station then Port C is probably correct.   
Consult your Psion’s manual if you are unsure. 

For advice on selecting an appropriate remote link baud rate, see Selecting the Link baud 
rate on page 25. 

You can change the PC communications settings by running the PsiLog Link program.   
See How to use the Link software on page 24. 

The PDL directory setting tells your Psion w here to look on your PC for the 
Starlog softw are package.   It is the same as the drive and directory on your PC w ithin 
w hich you installed the Starlog softw are, except that it must start w ith REM:: (for 
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remote).   For example, if you are using the Unidata Starflow  softw are package and you 
installed it into the default C:\STARFLOW directory, you must change this setting 
from the default of REM::C:\STARLOG\ to REM::C:\STARFLOW\. 

When you’ve finished, press Enter to accept the dialog settings. 

Optional Starlog files 

PsiLog can copy some Starlog softw are files from your PC.   PsiLog w ill operate 
perfectly w ell w ithout them, but some features may not be available. 

Formula file 
The Test Display screen uses this file to perform scaling calculations on data read from 
data loggers.   There is also a Formula Tester feature that can be used to test the 
operation of formulas. 

Not all Test Display screens require formulas.   For example, neither rain gauges nor 
Starflow  data loggers require formulas, how ever, thermistor and thermocouple probes 
do.   If you try to use an FTU file that requires a formula you don’t have, PsiLog w ill 
display the message Error loading FTU:Procedure not found. 

To allow  PsiLog access to these formulas, the file must be copied from your PC to the 
Psion.   Connect your Psion to your PC and start the PsiLog Link softw are.   See How 
to use the Link software on page 24 for more information.   Note that there is no need to 
start the Link softw are on your Psion; PsiLog w ill do that automatically. 

Next, press the Menu key and select Get formulas from PC from under the 
Special menu.   If you see the Formula tester function instead, you already 
have the formula file installed.   If you w ant to re-copy the formula file, you w ill have 
to exit PsiLog, delete the formula file yourself, then start PsiLog again.   The formula 
file is called PDLOUT.FOR and is stored in the \APP\PSILOG directory. 

 

The formula files w ill be copied automatically.   If you see the message Cannot 
find Starlog software, check your Remote link preferences (see page 42) and 
make sure the Port, Baud, and PDL directory settings are correct. 
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Version 3 logger test display files 
Version 3 logger test display files are used by the Logger Test Display option of the 
Test Display screen to display an appropriate FTU based upon the type of data logger 
connected.   These files are only available from Starlog/Starflow  Version 3 softw are 
packages (version 3.06 revision A or later).   To copy these files from your PC, follow  
these instructions: 

Connect your Psion to your PC and start the PsiLog Link softw are.   See How to use the 
Link software on page 24 for more information.   Note that there is no need to start the 
Link softw are on your Psion; PsiLog w ill do that automatically. 

Next, make sure you are in the Test Display screen by pressing Shift-Psion-T 
then press the Menu key and select Get from PC from the File menu. 

 
The files w ill be copied automatically.   For a full description of this procedure, see 
Transferring files from your PC on page 70. 

Version 2 logger test display files 
Version 2 softw are does not support the automatic FTU file selection that the Version 
3 softw are supports.   Instead, you can select from a set of predefined test displays.   
Since these files are built into the softw are and not supplied as separate files, you must 
follow  a special procedure to save them as files so PsiLog can copy them: 

1. Start PDLFTU.EXE. 
2. Press the Spacebar for the menu, then select Create a screen. 
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3. Name the screen PDLINFO and press Enter. 
 

 
 

4. Press the Spacebar again, then select PDL Information. 
5. Press the Spacebar again, then select Save Screen. 
6. Repeat steps 2 through 5 another three times, changing the steps as follow s: 

•  In step 3, change PDLINFO to MDLINFO, CFGINFO and BUFINFO. 
•  In step 4, change PDL Information to MDL Information, CFG 

Information and Buffer Info. 
7. Quit PDLFTU. 

8. Connect your Psion to your PC and start the PsiLog Link softw are.   See How 
to use the Link software on page 24 for more information.   Note that there is 
no need to start the Link softw are on your Psion; PsiLog w ill do that 
automatically. 

9. On your Psion, make sure you are in the Test Display screen by pressing 
Shift-Psion-T then press the Menu key and select the Get from PC 
option from the File menu.   The FTU files w ill be copied automatically. 

10. After PsiLog has finished coping the FTU files, you may delete them from 
your PC. 

Customising the Workabout to start PsiLog automatically 
Workabout computers can be configured to start an application automatically 
w henever they restart or are reset.   You can have PsiLog start automatically by setting 
the appropriate option.   Refer to the section under User interface preferences on page 39. 
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Online support 
Southern Cross Softw are Solutions provides online support for PsiLog on the World 
Wide Web and via email.   Our full contact details can be found on page 1. 

World Wide Web (WWW) 
On our w eb site you can find the latest updates to PsiLog, an electronic version of this 
User Guide (in Adobe PDF format), and various hints and tips.   The address of the 
PsiLog w ebsite is: 

http://www.scsoftware.com.au/psilog/ 

Email 
Southern Cross Softw are Solutions can be contacted via email.   For technical support 
and troubleshooting queries, please email: 

support@scsoftware.com.au 

Include in your email the version of PsiLog you are using, your PsiLog serial number 
(select Version from the Special menu to see your serial number) and w hat Psion 
computer you’re using.   Try to be as descriptive about your query as possible.   When 
emailing attached files (such as scheme files), please use an archiving program such as 
WinZip and compress them as a single attachment. 

For all other enquiries, please email: 

sales@scsoftware.com.au 
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The PsiLog Environment 
 
 
 
 
 

Introduction 
Common functionality 

Program logger 
Unload logger 

Data viewer 
Test display 

Velocity trace 
Communications window 
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Introduction 

The modes 

PsiLog operates in a number of different modes.   The various modes w ork together to 
allow  you to program your data loggers, check your data loggers to make sure the 
scheme is operating correctly, and unload the data they have collected for later transfer 
to your PC.   Each mode operates independently of the others in its ow n ‘w indow ’.   
The currently available modes are: 

•  Program logger (hotkey: Shift-Psion-P) 
•  Unload logger (hotkey: Shift-Psion-U) 
•  Data view er (hotkey: Shift-Psion-D) 
•  Test display (hotkey: Shift-Psion-T) 
•  Velocity trace (hotkey: Shift-Psion-V) 
•  Communications w indow  (hotkey: Shift-Psion-W) 

Although only one of these may be active at a time, you can easily sw itch betw een 
them using their ‘hotkeys’.   For easier single-finger operation, you may press Space 
to display the Select Mode w indow : 

 
Notice that the mode you’re currently in is show n in bold type.   Now , just press the 
letter show n on the button under each mode label to change to that mode.   Pressing 
Space or Esc w ill close the w indow  w ithout changing the mode. 

Alternatively, you can use the arrow  keys to move the bold type to a different mode 
and press Enter to select that mode. 

Note that the Communications Window  grabs the Space character for sending to the 
serial port instead of displaying the Select Mode w indow .   To change modes w hen 
using the Communications Window , you w ill have to either press the Shift-Psion 
hotkey or select the mode via the View and Change window menus. 

Most modes have a set of preferences that are used to customise them.   Select Set 
preferences from the Special menu.   On the right is the General menu 
covering preferences that affect PsiLog as a w hole.   To the left of it are the menus 
that affect the preferences of only the current mode. 
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Preferences are described on the follow ing pages: 

•  General preferences on page 39. 
•  Program logger preferences on page 51. 
•  Unload logger preferences on page 57. 
•  Test display preferences on page 78. 
•  Communications w indow  preferences on page 85. 

The display 

The PsiLog display is split into three sections, as show n below . 

 

 

The Window  area is alw ays visible and show s information pertinent to the current 
mode.   The Mode strip can be turned off via the User interface preferences (see page 39).   
The Status is the standard Psion status display and can be controlled via the usual 
Ctrl-Menu and Ctrl-Shift-Menu keys. 

Online help 

PsiLog has a context-sensitive online help system.   Press the Help key (Shift-Esc 
for Workabout computers) to display it at any time. 

 

Mode 

Status 

Window 
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Use the arrow  keys to scroll up and dow n.   Many of the help topics have links to 
related help pages at the bottom.   Scroll dow n to the bottom of the page, highlight the 
topic you w ant to view  and press Enter. 

To return to the previous help page, press Esc.   To close the help completely and 
return to PsiLog, press Ctrl-Esc. 

Single key operation 
PsiLog has been designed to allow , as much as possible, operation by pressing a single 
key at a time.   This makes operating the Workabout w ith one hand w hile holding it in 
the other much easier. 

By default, w hen you press a letter key PsiLog treats it as if you had held dow n the 
Psion key as w ell.   For example, if you are in the Unload logger mode and you w ant to 
do an unload, simply press the U key. 

How  PsiLog treats letter keys can be altered via the User interface preferences (see page 39). 

Of course, all functions are available through the menus.   While in the menus, you can 
use the arrow  keys to select a function, or you can press the letter corresponding to 
that function’s hotkey to jump to its position in the menus. 

 

Common functionality 
Each of the PsiLog modes has some common features.   The menus for each of the 
modes include the View  and Special menus. 

View menu 

The View menu is show n below : 

 

Via the View menu you can select a different w indow , or mode, and zoom in or out.   
Zooming in and out makes the text in the w indow  bigger and smaller respectively.   
When the text cannot become any bigger or smaller, the zooming ‘w raps around’ to 
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the other extreme.   In other w ords, zooming in from the biggest size text causes 
PsiLog to change the size of the text to the smallest possible size, and vice versa. 

Special menu 

The Special menu lets you access your PsiLog preferences, the formula tester, the 
PsiLog updater, modem controller, PsiLog version information, and the Exit 
command. 

 

Preferences menu 
The Preferences menu lets you customise the operation of PsiLog to your personal 
preferences and to the configuration of your Psion. 

 

Each group of preferences is described below : 

 
User interface preferences 

The user interface preference let you alter the appearance of the screen and how  
PsiLog responds to some keypresses. 
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•  Scrollbars – You can turn these Off to give more room to display 
information in the w indow . 

•  Beep – You can turn the beeping Off.   Error, w arning and information 
messages w ill still appear. 

•  Unmodified keys – This affects how  PsiLog treats keys that have been 
pressed w ithout the Psion, Shift or Ctrl keys held dow n at the same 
time.   This can be used to improve the single-handed operation of PsiLog.   
For example, if this option is set to as Shift-Psion then pressing the T, 
U, P, and W keys w ill jump to the Test Display, Unload Logger, Program 
Logger and Communications Window  modes directly, w ithout requiring you 
to hold dow n the Shift and Psion keys at the same time. 

•  Show mode – This controls the display of the thin black strip that show s the 
current mode.   It can be turned off to make more room to display 
information in the w indow . 

•  Scrolling – This affects how  the arrow  keys scroll the display.   You can 
scroll either character-by-character, in half-screen jumps or in full-screen 
jumps.   Each of these jumps can be made either by using just the arrow  keys, 
or by holding dow n the Ctrl key w hile pressing arrow  keys. 

•  Cache size – This affects the responsiveness of PsiLog.   A small cache size 
can slow  the operation of PsiLog, depending on w hat it is doing.   Testing by 
SCSS has determined the default of 8000 provides the best balance betw een 
speed and memory consumption.   How ever, if you find that you need a little 
more memory, this can be reduced in decrements of 500.   Alternatively, if 
you feel that PsiLog is too slow , increasing this value in increments of 500 
may help.   You can fine tune using changes smaller than 500.   Be careful, if 
you set the cache size too big, PsiLog may not have enough memory left to 
run!   See also Required memory on page 94 and Resetting PsiLog preferences on 
page 96. 
IMPORTANT NOTE: You must exit and restart PsiLog for changes to this 
preference to take effect. 

•  Autostart – On Workabout computers, PsiLog can be set to start 
automatically w henever the computer restarts.   Set this option to Yes to 
enable automatic starting.   In some instances it may not be possible for 
PsiLog to automatically start.   In that case, the option is not available and 
alw ays set to No.   This is alw ays the case for non-Workabout computers. 
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Communications preferences 

The Communications preferences affect how  PsiLog accesses its communications 
port.   PsiLog ignores scheme communications settings, so it is important the Port 
and Baud selections are correct. 

 

•  Port – This is the serial port PsiLog w ill use to talk to data loggers.   Most 
Psions have just one serial port called A.   Some Workabout computers may 
have other serial ports called by different letters.   Consult your Psion’s 
manual to determine w hich is the correct port to use. 

•  Baud – This is the baud rate to use.   If you are connecting directly to your 
data logger this must be the same as the baud rate set in the data logger 
(usually 9600).   If you are using a modem, this should be set to the slow est 
speed greater than or equal to the maximum baud rate supported by the 
modem.   For example, for a 14400-baud modem, use 19200 baud. 

•  Timeout – This is how  long PsiLog should w ait for a response from the data 
logger.   It is specified in 0.1-second units.   If you are communicating w ith a 
data logger that uses extremely long scan rates (not log intervals) of an hour 
or more, then this should be set to about 10 seconds.   If you are 
communications w ith a standard logger, this should be set to be longer than 
the longest prompt interval.   Typically, the longest interval is 15 seconds.   
PsiLog defaults to 20 seconds.   If you set the timeout to too short a value 
(the minimum value depends on the Baud and Buffer size settings) 
PsiLog w ill beep, display the message Timeout reset to minimum, 
and re-display the dialog w ith the timeout set to the minimum value. 

•  Buffer size – This is the size of the buffer used to receive data from data 
loggers.   This value limits the largest amount of data PsiLog can request 
from the data logger in one go.   The default of 8500 bytes comfortably 
allow s PsiLog to request up to 4096 bytes of data from the data logger.   
Note that w hen data loggers transmit data, it is expanded by a factor of tw o! 
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Remote link preferences 

The Remote link preferences affect how  PsiLog communicates w ith your PC. 

 

•  Port – This is the serial port PsiLog w ill use to transfer files to and from 
your PC computer.   It is likely to be the same as that in the 
Communications preferences above.   Workabout computers may be able 
to use different ports.   Consult your Psion’s manual to determine the 
correct ports to use. 

•  Baud – This should typically be set as fast as possible.   See Selecting the 
Link baud rate on page 25 for more information. 

•  PDL directory – This is the directory on your PC w here you have installed 
the Unidata Starlog softw are package.   It should alw ays start w ith REM:: 
to indicate that the Starlog softw are is remote from the Psion.   The default 
is REM::C:\STARLOG\. 

•  Update directory – This is the directory on your PC w here you put 
updates to the PsiLog program.   It should alw ays start w ith REM:: to 
indicate that the update files are remote from the Psion.   The default is 
REM::C:\TEMP\. 

•  Timeout – This is how  long PsiLog should attempt to connect to your PC 
w hen it needs to send or receive files. 

 

Scheme preferences 

The Scheme preferences affect w here PsiLog stores schemes and unloads on the 
Psion. 

•  Schemes – This is the directory on your Psion w here PsiLog w ill store the 
files related to your schemes.   The Program Logger mode w ill look in this 
directory for schemes w ith w hich to program the data logger, the Test 
Display mode w ill look here for Scheme Test Display files, and the Modem 
dialler w ill look here for schemes w ith telephone numbers. 

•  Unloads – This is the directory w here PsiLog w ill store unloaded data.   
This does not have to be w here you keep scheme files on your Psion.   In 
fact, PsiLog doesn’t need any scheme files to be able to unload data loggers!   
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For example, you may prefer to store unloaded data on a high-capacity 
Flash SSD, but keep all other files on the internal RAM disk. 

 

 

Formula tester 
The formula tester allow s you to perform manual calculations using formulas in the 
PDLOUT.FOR file.   Such formulas include those for thermistors and thermocouples. 

If you don’t have the PDLOUT.FOR file installed, you w ill see Get formulas 
from PC instead.   Refer to Optional Starlog files on page 30. 

The formula tester lets you select the formula from a list.   You can also just start 
typing the name of the formula if you know  the one you w ant. 

 

You can alw ays calculate from the Argument to the Result.   Some formulas also 
let you calculate backw ards from the Result to the Argument.   If the formula 
doesn’t allow  backw ards conversion, PsiLog w ill let you know . 

Some formulas require the Log Buffer to be set up.   Such formulas include the w ind 
direction formulas.   There is no w ay for PsiLog to automatically determine w hich 
formulas require the Log Buffer.   You must examine the formula yourself.   Refer to 
the Data field format on page 75 for information on w hat you can enter in the Log 
Buffer field. 
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Update PsiLog 
The PsiLog Update function lets you automatically update PsiLog w hen SCSS makes 
updated versions available.   It uses the Remote Link preferences to communicate with 
your PC. 

You can receive updates in a couple of w ays.   The first is via a compressed archive, or 
ZIP file.   You w ould extract the files using an ‘un-zipping’ utility into a temporary 
directory, such as C:\TEMP.   The second w ay is via a floppy disk.   In this case the 
files are already unpacked and may be used directly. 

 
Directory settings 

In both cases, PsiLog needs to know  w here to look for its updated files.   You give 
PsiLog this information in the Update directory setting in the Remote Link preferences 
dialog.   See Remote link preferences on page 42. 

In the case of the archive, it is the directory you extracted the files into.   From the 
example given above, the correct setting w ould be REM::C:\TEMP\. 

In the case of the update files being on a floppy disk the correct setting might be 
REM::A:\, assuming that the floppy disk drive on your PC is the A: drive.   Change 
it as appropriate if your floppy disk drive uses a different letter. 

 
Updating PsiLog 

Connect your Psion to your PC and start the PsiLog Link softw are.   See How to use the 
Link software on page 24 for more information.   Note that there is no need to start the 
Link softw are on your Psion; PsiLog w ill do that automatically. 

Next, select Update PsiLog from the Special menu. 

 
PsiLog w ill establish a link w ith your PC and start transferring the new  PsiLog files.   If 
PsiLog cannot find any update files it w ill beep and display Could not find 
update files.   Check your Remote link preferences (see page 42) and make sure the 
Port, Baud, and Update directory settings are correct. 

If all goes w ell, the follow ing w indow  w ill appear on the screen show ing the progress 
of the transfer: 
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If there are any problems, PsiLog w ill beep and show  a message indicating w hat the 
problem is. 

When the transfer is complete, the screen w ill go blank for a few  moments w hile 
PsiLog updates its files before restarting. 

 
Update in detail 

To assist in troubleshooting, the follow ing describes the update procedure in detail: 

•  PsiLog connects to the PC and scans the Update Directory for all files w ith 
a name starting w ith PSILOG.   Each such file is added to a list. 

•  PsiLog copies each file on its list to the Psion, placing each one in the same 
directory as the file it is replacing, but changing its name so that it starts 
w ith _SILOG.   In other w ords, PsiLog does not replace the old files 
immediately.   This also means that your Psion must have enough free 
space for two copies of PsiLog at once! 

•  When all the files are copied, PsiLog deletes each old file and renames each 
new  file from _SILOG… to PSILOG… in turn. 

•  Once all the files are renamed, PsiLog restarts. 

 

M odem 
The Modem function lets you take control of a modem connected to your Psion via 
the serial port.   It uses the same Communications settings used to connect to your 
data loggers, and not the Remote Link communications options. 

The telephone number format is the same as for the Starlog softw are.   PsiLog 
recognises both the Qxx and Mxx Telemetry Sw itch and Multidrop suffixes.   Note 
that Multidrop communications is not possible over modems. 

When dialling out, PsiLog w ill remember the last telephone number dialled, and so 
long as you haven’t hung up the telephone in the meantime, PsiLog w ill not attempt to 
re-dial the number.   This is of benefit w hen you are communicating w ith several data 
loggers using the same telephone number and connected via a Telemetry Sw itch card.   
If you dial the first number (eg. ‘12345678Q00’) PsiLog w ill dial the telephone and 
send the Q-command as normal.   If you subsequently select the next data logger at 
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the site (eg. ‘12345678Q01’), PsiLog w ill just send out the new  Q-command (‘Q01’) 
and not hang up the telephone and redial the number. 

If the telephone connection is lost for any reason, including w hen you Hangup the 
modem, PsiLog w ill briefly display the message Modem disconnected and beep. 

 

Dialling to a particular scheme 

PsiLog w ill scan the available schemes to determine if any have telephone numbers set.   
If they do, the scheme w ill appear in the Scheme list.   Simply select the scheme to 
use and press Enter w hile Scheme is highlighted. 

If none of the available schemes have telephone numbers set, the Scheme line w ill 
read None available and you w ill not be able to select it. 
Dialling to a particular telephone number 

If there is a particular telephone number you w ant to dial, enter the number on the 
Number line and press Enter w hile Number is highlighted.   If you have a 
Telemetry Sw itch at the site, follow  the telephone number w ith the letter Q follow ed 
by the sw itch number.   If you are using Multidrop communications, simply enter the 
letter M follow ed by the logger serial number.   Remember that Multidrop 
communications does not w ork over a modem. 
Hanging up the modem 

When you have finished communicating w ith the remote data logger, highlight 
Hangup and press Enter.   When the modem disconnects, PsiLog w ill briefly 
display the message Modem disconnected and beep. 
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Version 
This command displays PsiLog version information: 

 

Exit 
This command exits PsiLog. 
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Program logger 

Introduction 

This mode allow s you to program your data logger w ith a scheme.   PsiLog cannot 
generate schemes by itself.   Instead, you must transfer to your Psion one or more 
schemes already created on your PC using the Unidata Starlog softw are package. 

By default, the scheme files are stored in a directory called \STARLOG on your 
Psion’s Internal disk.   Setting the Directory in the Scheme preferences dialog 
can change this.   See Scheme preferences on page 42. 

To save space PsiLog only copies the scheme files it needs to the Psion.   These are the 
*.CDT, *.CFG, *.ENT, *.FTU, *.INI, *.KBD and *.LDR files.   Note that not 
all schemes have all of these files available.   PsiLog w ill handle missing files 
automatically. 

Transferring schemes from your PC 

Before you can use PsiLog to program your data logger, you must copy the scheme 
from your PC. 

To do this, connect your Psion to your PC and start the PsiLog Link softw are.   See 
How to use the Link software on page 24 for more information.   Note that there is no 
need to start the Link softw are on your Psion; PsiLog w ill do that automatically.  

Next, make sure you are in the Program Logger mode by pressing Shift-Psion-P 
then select Get from PC from the File menu. 

 

PsiLog w ill establish a link w ith your PC and get a list of the available schemes. 

If you see a Cannot find Starlog software message, check your Remote 
link preferences (see page 42) and make sure the Port, Baud, and PDL directory 
settings are correct. 
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If all goes w ell, the follow ing dialog w ill appear on the screen: 

 

The ‘*’ is a special scheme name that means ‘select all of the schemes’.   If you don’t 
w ant to copy every scheme to your Psion, then select the particular one you w ant from 
the list.   It is not possible to select more than one scheme to transfer at a time, other 
than by using the ‘*’ name and copying all of them.   Press Enter to have PsiLog 
copy the scheme(s) you have selected. 

PsiLog w ill show  the progress of the transfer: 

 

PsiLog w ill show  Done! w hen the transfer is complete. 

Programming a logger 

Before you can program your data logger, you must first copy the required scheme 
from your PC.   See Transferring schemes from your PC on page 48 for more information. 

When programming the data logger, the date/time of your Psion computer is 
used to set the date/time of the logger.   Make sure your Psion computer is set 
to the correct date/time before programming any data loggers. 

����
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First, connect your Psion to your data logger.   Make sure you are in the Program 
Logger mode by pressing Shift-Psion-P then select Program logger from 
the File menu. 

 

A dialog w ill appear w ith the schemes that are on your Psion. 

 

Select the scheme w ith w hich you w ant to program the data logger and press Enter.   
PsiLog w ill start programming the data logger.   When finished, PsiLog w ill show  
Program complete. 

 

If you see a Too many retries message, try again.   It may be helpful to increase 
the retry value.   See Preferences on page 51.   It could also be that the scheme has 
configured the logger to use a different baud rate.   In this case, to program the logger 
you must first set PsiLog to communicate at the logger’s current baud rate, then select 
Program logger from the File menu.   It should get past the Configuring 
logger stage and fail w hen it gets to Loading display.   You w ill have to set 
the Communications preferences (see page 41) to the new ly configured baud rate and start 
the logger programming again. 
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Deleting a scheme 

If you’re short on disk space, you can delete the files associated w ith schemes.   Each 
set of scheme files uses about 2K.   Unload files are never deleted (see Deleting 
unloads on page 56 if that’s w hat you w ant to do). 

Make sure you are in the Program Logger mode by pressing Shift-Psion-P then 
select Delete a scheme from the File menu. 

 
A dialog w ill appear w ith the schemes that are on your Psion. 

 
Select the scheme you w ant to delete and press Enter.   Another dialog w ill appear 
asking you to confirm that you w ant to delete the scheme files.   If you select Yes the 
scheme files w ill be deleted. 

Preferences 

The only option for Program Logger is the number of times to retry failed 
communications requests. 
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Unload logger 

Introduction 

This mode allow s you to unload your data logger and later transfer that data to your 
PC.   The unloaded data can be stored in your Psion’s internal memory or onto 
separate SSD memory cards.   Both RAM and Flash SSDs are supported.   At the time 
of w riting, the largest RAM SSD has a 1MB capacity and the largest Flash SSD has 
8MB. 

By default the unload files are stored in a directory called \STARLOG on your Psion’s 
Internal disk.   Setting the Unloads directory in the Scheme preferences dialog can 
alter that.   See Scheme preferences on page 42. 

PsiLog does not need to have access to scheme information in order to unload a data 
logger.   All the information needed to unload a data logger is already present inside 
the data logger itself. 

The main w indow  of this mode show s the free disk space available on the Psion.   This 
includes the main internal RAM disk, plus any SSDs you might have installed. 

 

Unloading a logger 

You can unload any data logger programmed w ith a scheme generated by the Unidata 
Starlog softw are package.   Connect your Psion to the data logger, make sure you are in 
the Unload Logger mode by pressing Shift-Psion-U then select Unload 
logger from the File menu. 
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A dialog w ill appear allow ing you to adjust the unloading options. 

 

By default, the unload is Incremental.   This means that only data logged since 
you last unloaded w ill be transferred.   If you w ant to unload everything, then select 
Full unload.   You can also enter a Comment, if you like.   The Max logs option 
limits the number of logs transferred, counting from the start of the unload.   This can 
be useful to limit the time spent unloading data.   Note that for a full unload the start 
of the unload is alw ays the earliest data available in the log buffer.   For an incremental 
unload the start is taken as the first data logged after the incremental unload pointer or, 
if that has been overw ritten, the earliest data available in the log buffer (the same as for 
a full unload). 

Press Enter to accept the unload settings.   Another dialog w ill appear to show  the 
progress of the unload. 

 

When the unload is complete, PsiLog w ill show  Unload complete. 

 

If you see a Unload failed message, try again.   It may be helpful to increase the 
retry value.   See Preferences on page 57. 
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If you see a Disk full message as soon as you start an unload, PsiLog has 
determined that the unload w ill not fit into the available disk space.   You have several 
options: 

•  Set the Unload directory of the Scheme preferences to a different disk.   
See Scheme preferences on page 42. 

•  Change SSDs, if you’re using SSDs. 
•  Set Max logs to limit the number of logs to unload. 

Transferring data to your PC 

To view  and produce reports on data you have unloaded, you need to transfer the data 
to the Starlog softw are package installed on your PC. 

To do this, connect your Psion to your PC and start the PsiLog Link softw are.   See 
How to use the Link software on page 24 for more information.   Note that there is no 
need to start the Link softw are on your Psion; PsiLog w ill do that automatically.  

Make sure you are in the Unload Logger mode by pressing Shift-Psion-U then 
start the PsiLog transfer by selecting Send to PC from the File menu: 

 

This w ill start the fully automated file transfer.   If you see a message Cannot find 
Starlog software check your Remote link preferences (see page 42) and make sure 
the Port, Baud, and PDL directory settings are correct. 

PsiLog w ill check the unload files it has against the schemes present on the PC.   All 
unloads stored on the Psion that have a corresponding scheme on the PC w ill be 
copied to the PC.   PsiLog w ill automatically update the Starlog softw are index file and 
incremental unload pointers. 
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While the transfer is taking place, PsiLog w ill show  a progress dialog: 

 

When the transfer is complete, the PC Link softw are w ill return to the w aiting state 
and PsiLog w ill show  Done: 

 

Note that PsiLog can optionally delete each unload from the Psion as it is transferred 
to the PC.   See Preferences on page 57. 

Synchronising incremental unloads 

There is no need to unload the entire data buffer each time you unload a data logger as 
PsiLog allow s you to perform incremental unloads. 

These w ork by storing a record of the date and time on the most recently unloaded 
data from a data logger.   Then, the next time that data logger is unloaded, only data 
logged since then is considered. 

Since it is possible for both your PC and your Psion to be performing unloads, it is 
important to keep these records up-to-date.   The Get IUPs function of PsiLog 
ensures that your Psion has the most up-to-date records of incremental unloads. 

If you have unloaded data from a logger to your Psion, you should transfer it to 
the PC before synchronising the incremental unload pointers.   This ensures that 
the incremental unload pointers on the PC are the most recent.   See Transferring 
data to your PC on page 54. 

To do this, connect your Psion to your PC and start the PsiLog Link softw are.   See 
How to use the Link software on page 24 for more information.   Note that there is no 
need to start the Link softw are on your Psion; PsiLog w ill do that automatically. 

����
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Make sure you are in the Unload Logger mode by pressing Shift-Psion-U then 
start the transfer by selecting Get IUPs from the File menu: 

 

The transfer is fully automatic.   All the incremental unload records (the IUP files) on 
your PC w ill be copied to your Psion: 

 

When the transfer is complete PsiLog w ill show  Done: 

 

If you see a Cannot find Starlog software message, check your Remote 
link preferences (see page 42) and make sure the Port, Baud, and PDL directory 
settings are correct. 

 

Deleting unloads 

To free space on your Psion, you can delete data you have unloaded from your data 
logger. 

Note that deleting data from Flash SSDs does not free disk space until the SSD is 
reformatted.   See your Psion’s manual for more information. 
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Make sure you are in the Unload Logger mode by pressing Shift-Psion-U then 
select Delete an unload from the File menu. 

 
A dialog w ill appear, allow ing you to select an unload file.   If PsiLog cannot find any 
unload files it w ill display the message No unload files found!.   Use the 
Up/Down arrow  keys to select the file. 

 
Press Enter to accept the selected unload file.   PsiLog w ill ask you to confirm the 
deletion.   Be certain that you w ant to delete the unload file as once a file is deleted it 
cannot be recovered. 

You can set a preference to have PsiLog automatically delete unload files w hen they 
are transferred to your PC.   See “Delete unloads” in Preferences below . 

 

Preferences 

The Unload Logger preferences let you alter the behaviour of the data unloader 
function of PsiLog. 

 

•  Retries – This is the number of times PsiLog w ill make the same request of 
the data logger before giving up. 
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•  Delete unloads – This controls w hat PsiLog does w ith the unloaded data 
after it has been transferred to the PC.   If it is Yes, unloaded data is deleted 
after it has been transferred, if No the data is left alone and must be deleted 
later.   See Deleting unloads on page 56.   Note that deleting data from Flash 
SSDs does not free disk space until the SSD is reformatted.   See your Psion’s 
manual for more information. 

•  Request size – This is the maximum size PsiLog w ill use to transfer data 
from the data logger.   If more than the request size is required to be sent 
from the data logger, PsiLog w ill break it up into multiple portions not larger 
than the request size.   If the communications link is poor quality, setting this 
to a smaller value may improve the speed of communications.   Conversely, 
w hen the communications link is of high quality (reasonably error-free), then 
a larger value may improve the speed of communications. 
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Data viewer 

Introduction 

This mode allow s you to view  logged data.   It is the same as the PDLOUT program 
and part of the PDLFTU programs that are part of the Starlog softw are package on PC 
computers.   Using the Data View er, you can make sure the data logger is performing 
correctly after programming and you can also review  data unloaded from the logger. 

A tabular view  of your logged data is available for unload files and w hen directly 
view ing the data logger memory buffer.   A plot graph is only available for unload files. 

The tabular view  is split into tw o parts: the Header and the Data areas.   The Header is 
alw ays at the top and can be toggled betw een show ing Titles, Units, Comments, and 
Actions.   The plot view  displays a single channel at a time and automatically scales the 
vertical axis to fit the data.   You can zoom in and out of the plot view  to examine data 
in detail. 

To view  unload data, PsiLog requires that you have your scheme program files copied 
to your Psion.   Note that if you previously transferred the scheme files to your Psion 
in order to be able to program your data logger, you do not need to transfer the 
scheme files again. 

To copy the scheme files to your Psion, refer to Transferring schemes from your PC on page 
48.   This w ill copy all the scheme program files, plus the files required by the Data 
View er. 

Checking your scheme 

Connect your Psion to your data logger.   Make sure you are in the Data View er mode 
by pressing Shift-Psion-D then select Logger buffer from the File 
menu. 

 
PsiLog w ill read the name of the scheme from your data logger and load the 
appropriate display screen.   The display w ill show  the data logged most recently. 
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If PsiLog beeps and displays the message Cannot find schemename.ent, 
then make sure you have copied the scheme files to your Psion.   See Transferring schemes 
from your PC on page 48. 

If the message is Error loading ENT:Procedure not found, then the 
formula file is missing.   Refer to Optional Starlog files on page 30. 

The keys you can use to view  the unload buffer are explained in the next section. 

Viewing an unload 

Make sure you are in the Data View  mode by pressing Shift-Psion-D then select 
Open unload from the File menu. 

 
A dialog w ill appear, allow ing you to select an unload file.   Use the Up/Down arrow  
keys to select the file.   If PsiLog cannot find any unload files it w ill display the 
message No unload files found!. 

 
Press Enter to accept the selected unload file.   PsiLog w ill read the name of the 
scheme from inside the unload file and load the appropriate display screen. 
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If PsiLog beeps and displays the message Cannot find schemename.ent, 
then make sure you have copied the scheme files to your Psion.   See Transferring schemes 
from your PC on page 48. 

If the message is Error loading ENT:Procedure not found, then the 
formula file is missing.   Refer to Optional Starlog files on page 30. 

When view ing logged data, the follow ing keys may be used to navigate: 

•  Left/Right arrow s w ill scroll the display left and right. 

•  Up/Down arrow s w ill scroll the display up and dow n 

•  PgUp/PgDn keys (Psion-Up Arrow and Psion-Down Arrow on a 
Workabout) w ill scroll the display up and dow n an entire screen full at a time. 

•  Home/End keys (Psion-Left Arrow and Psion-Right Arrow 
on a Workabout) w ill jump up to the beginning and dow n to the end of the 
data respectively. 

•  / changes the heading row  betw een Title, Units, Comment, and Action. 

Note that w hen you are view ing the log buffer inside a data logger, pressing the End 
(Psion-Right Arrow on a Workabout) key w ill go to the end of the data and 
‘stick’ there.   When new  data is logged, the display w ill automatically display the new  
data, scrolling up if necessary.   Using the other navigation keys to scroll up or dow n 
w ill turn the ‘stick to end’ feature off.   Press End (Psion-Right Arrow on a 
Workabout) to reactivate it. 

Finding a date 
When view ing an unload file, you can have PsiLog search for a particular date/time.   
Select Find date from the File menu. 
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If you get the message Find date not available, then you aren’t view ing an 
unload file.   If you’re view ing a plot, select Hide plot from the File menu, 
otherw ise select Open unload from the File menu.   You cannot find a 
date/time in the Logger Buffer view . 

Enter the date/time you w ant PsiLog to move to in the dialog: 

 
Press Enter to accept the dialog and PsiLog w ill search for the date/time and display 
the first logged data on or after the date/time from the top of the screen.   If the 
date/time is after the end of the data in the unload file, the current position does not 
change. 

Viewing a plot 

To view  a plot, select Show plot from the File menu. 

 
If you get the message Can only plot unload files, then first make sure 
you are view ing an unload file.   See Viewing an unload on page 60. 

The Log Entry selection dialog w ill appear: 

 
Select the log entry to plot and press Enter.   Press Esc if you decide not to view  a 
plot. 
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To return to the tabular view  of the unload file, select Hide plot from the File 
menu. 

Plotting can take a long time.   PsiLog first has to “range” the data – determine the 
extremes of the data it has to fit on the screen – then actually plot the data.   While 
PsiLog is ranging and plotting, the messages Finding ranges and Plotting 
are show n at the bottom left of the screen.   You can press Esc to stop plot ranging 
and draw ing.   If you do stop the ranging or plotting, the undraw n portion of the plot 
w ill be shaded. 

When you sw itch back to the tabular view , PsiLog w ill automatically position the data 
corresponding to the left of the plot at the top of the display. 

The Plot Display 
Plots are displayed one log entry at a time and start out show ing the entire unload file. 

 
Pressing Tab w ill open the Log Entry selection dialog w here you can select a different 
log entry to plot. 
Gridlines 

Gridlines may be show n corresponding to the tick marks on each axis.   See Preferences 
on page 66 for the options for gridlines. 
Date/Time W indow 

At the bottom of the above screen shot is a w indow  obscuring the X-axis.   This 
w indow  show s the exact date/time of the range of data displayed.   This w indow  can 
be toggled on and off by pressing the / (slash) key or toggled betw een the top and 
bottom of the screen by pressing the Up/Down arrow  keys. 

When zooming it displays the start/end date/times of the highlighted area. 
Title 

The title at the top show s the name of the log entry, and the type of logging performed 
(maximum, average, etc). 
Y-Axis (Log Entry) 

The Y-axis dow n the left side of the plot is automatically scaled to fit the data show n 
on the screen.   The units are show n at the very left of the screen. 
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A screen shot below  show s Y-axis label values that have been scaled.   The “÷103” at 
the top of the Y-axis indicates that you must divide the Y-axis label values by 103 
(1000) to get the true label values.   The scaling value is alw ays a pow er of ten.   The 
pow er factor is alw ays a multiple of three. 
X-Axis (Time) 

The X-axis across the bottom of the screen alw ays show s the date/time.   The 
follow ing screen shot has the date/time w indow  turned off, revealing the X-axis: 

 
The X-axis is labelled in short form by only displaying the most significantly changing 
parts of the date/time.   For example, if the range of times covers more than an hour 
(but less than a day), then hours w ith optional minutes and seconds w ill be show n. 

In the above screen shot, the bottom left of the screen show s HHMM.   This indicates 
the parts of the date/time show n on the X-axis.   In this case, the HHMM signifies that 
hours and minutes are show n. 

Betw een one and three parts of the date/time may be show n at each tick on the X-
axis.   For information on selecting how  many parts to show , see Preferences on page 66.   
The available date/time parts are: 

Date part Description  Date part Description 
YY Year  HH Hour 
MM Month  MM Minute 
DD Day  SS Second 

The context of MM determines w hether it is referring to Month or Minute.   If you’re 
unsure, use the / (slash) key to toggle the more detailed date/time w indow . 

The possible date/time short forms are: 

One part Tw o parts Three parts Used w hen date/time range is… 
YY YYMM YYMMDD More than a year 
MM MMDD MMDDHH More than a month, less than a year 
DD DDHH DDHHMM More than an day, less than a month 
HH HHMM HHMMSS More than a hour, less than a day 
MM MMSS MMSS More than a minute, less than an hour 
SS SS SS Less than a minute 
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If PsiLog determines that the last (right most) part is the same for each axis tick, 
PsiLog w ill shuffle the parts along to remove the redundant part and reveal a 
potentially more interesting part.   For example, if the selected form is HHMMSS, but 
the seconds are alw ays zero (because the axis interval is, say, tw o minutes), then PsiLog 
w ill change the format to DDHHMM. 

Zooming 
It is possible to zoom in to a section of the plot to see the data in more detail.   When 
zooming, PsiLog alw ays displays the entire unload file and highlights the currently 
selected section.   The + key shrinks the highlight (zooms in).   The – key expands the 
highlight (zooms out).   The Left/Right arrow  keys move the highlight left and 
right. 

The date/time w indow  (w hen visible) show s the date/time range of the highlighted 
data: 

 
When the required area is highlighted, press Enter to redraw  the plot w ith the 
selected data filling the screen.   Pressing Esc cancels the zoom. 

Pressing the * (star or asterisk) key w ith the highlight active w ill cause the plot to 
zoom out so that the plot currently being displayed w ill fit into the highlight. 

Pressing the * (start or asterisk) key w hen the highlight is not active w ill cause the plot 
to zoom right out and display the log channel for the entire unload file (the starting 
view ). 

Key Summary 
Keys Description 
Tab Change the log entry being plotted. 
/ Toggle the date/time w indow  on/off. 
Up/Down arrow s Toggle the position of the date/time w indow  betw een the 

top and bottom of the screen. 
+/-† Shrink/expand highlight (zoom in/out). 
Left/Right arrow s† Move the highlight left/right. 
Enter When zooming, redraw s the plot w ith the highlighted area 

filling the plot area. 
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Esc When zooming, cancels the zoom. 
* When zooming, zooms out so that the currently visible part 

of the plot is rescaled to fit into the highlight.   When not 
zooming, zooms right out to show  the entire unload file (the 
starting view ). 

†If not already zooming, these keys w ill activate the zoom mode (highlighting). 

Preferences 

The Data View er preferences let you set options related to plotting: 

 
Gridline options may be set individually for the X (time) and Y (log entry value) axes. 

� X axis labels – One of  One part, Two parts, or Three parts.   
This controls the size of the labels at each tick on the X-axis.   Few er parts 
result in shorter labels, and therefore more ticks (and gridlines) can fit on the 
axis. 

� Grid colour – One of Off, Black, or Grey.   If you are running short of 
memory, black is the preferred colour as using grey requires some extra 
memory. 

� Grid style – One of Solid or Dotted.   Dotted is the recommended 
style for use w ith the Black colour.   Either style is good w ith Grey. 

Exporting an unload 

Unload files can be exported by PsiLog in a variety of formats.   Data is alw ays 
exported to a specific directory, selected via preferences.   See Preferences on page 68 for 
more information. 

To export an unload file, make sure you are in the Data View  mode by pressing 
Shift-Psion-D then select Export from the File menu. 
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If you are not view ing an unload file you w ill get the message Can only export 
unload files.   If you are view ing an unload file, the Export dialog w ill appear: 

 
This dialog controls how  the unload data is exported.   The dialog title show s the name 
of the unload file being exported.   The name of the exported file is based on the 
unload filename, unload number, and the export Format.   See foo in page bar for 
more information. 

� Range to export – The Start/End date/time fields default to the 
entire unload if you w ere looking at a tabular view  of the unload file.   If you 
w ere looking at the graphical (plot) view  they default to the range of data you 
w ere looking at. 

� Format of export – The Format and Header rows… fields control the 
form of the export.   Format can be one of Text (Tab) w here the fields 
are separated by tab characters, Text (CSV) w here the fields are separated 
by commas, or Lotus (WK1) w here the fields are exported as a 
spreadsheet.   Pressing the Tab key on the Header rows… field opens a 
sub-dialog w here you can select how  the header row s should appear (if at all).   
Each row  can be set to None (the header row  is skipped), Title (eg 
“Time”, “Temp”), Action (eg “RAW”, “AVE”), Units (eg “degC”, 
“mm”), Title(Action) (eg “Time(RAW)”, “Temp(AVE)”), or 
Title(Units) (eg “Time”, “Temp(degC)”. 

� What to export – The Entries field control w hether all the logged entries 
w ill be exported, or just one particular one.   The date/time is alw ays 
exported. 

Press Enter to accept the export settings and export the data.   If the export 
directory is on your PC, PsiLog w ill connect to PsiLog Link (w hich must be running 
on your PC) and transfer the file. 
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Preferences 

The Data View  Exporting preferences let you set options related to exporting: 

 
� Directory – This is the directory all export files w ill be saved to.   If it starts 

w ith REM:: it is a directory on your PC.   Make sure PsiLog Link is running 
on your PC and the tw o computers are connected via a serial cable.   The 
default is REM::C:\STARLOG\SCHEMES\. 

� Unload number in – This controls w here the unload number is placed in 
the name generated for the export file.   Scheme names can be up to eight 
characters long.   Extensions for the unload formats are TXT, CSV, and WK1.   
There is no more room for unload numbers w ithout replacing part of either 
the scheme name or extension.   If the unload file named ROOMTEMP.U99 
w as exported as a Text (CSV) file, then setting this field to Scheme name 
w ill result in the export file being named ROOMTE99.CSV.   Setting this 
field to Extension w ill result in the export file being named 
ROOMTEMP.C99. 
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Test display 

Introduction 

This mode allow s you to test the operation of your data loggers.   It is the same as the 
PDLFTU program that is part of the Starlog softw are package on PC computers. 

Via the Test Display, you can check that your data logger is operating correctly and 
that your scheme program is logging data. 

Checking your scheme 

Scheme test display 
For this function, PsiLog requires that you have your scheme program files copied to 
your Psion. 

Note that if you previously transferred the scheme files to your Psion in order to be 
able to program your data logger, you do not need to transfer the scheme files again. 

To copy the scheme files to your Psion, refer to Transferring schemes from your PC on page 
48.   This w ill copy all the scheme program files, plus the files required by the Scheme 
Test Display. 

Connect your Psion to your data logger.   Make sure you are in the Test Display mode 
by pressing Shift-Psion-T then select Scheme test display from the 
File menu. 
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PsiLog w ill read the name of the scheme from your data logger and load the 
appropriate display screen. 

 

If PsiLog beeps and displays the message Cannot find schemename.ftu, 
then make sure you have copied the scheme files to your Psion.   See Transferring schemes 
from your PC on page 48. 

If the message is Error loading FTU:Procedure not found, then the 
formula file is missing.   Refer to Optional Starlog files on page 30. 

Checking your logger 

Transferring files from your PC 
Before you can use the Test Display mode for the first time, you must copy several 
files from your PC. 

To do this, connect your Psion to your PC and start the PsiLog Link softw are.   See 
How to use the Link software on page 24 for more information.   Note that there is no 
need to start the Link softw are on your Psion; PsiLog w ill do that automatically.  

Next, make sure you are in the Test Display mode by pressing Shift-Psion-T 
then select Get from PC from the File menu. 

 

PsiLog w ill automatically copy all the required files from your PC to the Psion. 

If you see a Cannot find Starlog software message, check your Remote 
link preferences (see page 42) and make sure the Port, Baud, and PDL directory 
settings are correct. 
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See also Optional Starlog files on page 30. 

Logger test display 
Connect your Psion to your data logger.   Make sure you are in the Test Display mode 
by pressing Shift-Psion-T then select Logger test display from the 
File menu. 

 

PsiLog w ill attempt to identify your data logger and display an appropriate screen.   
Below  is part of the test display screen for a Starlogger: 

 
If PsiLog beeps and displays the message Unable to identify logger it 
could be that: 

•  Some files that PsiLog requires have not been copied to your Psion.   Refer 
to Transferring files from your PC on page 70 for instructions on how  to copy 
these files. 

•  There w as a communications problem.   Check the data logger, cable, and 
settings and try again.   See also the Troubleshooting section starting on page 87. 

If the message w as Error loading FTU:Procedure not found then the 
formula file is missing.   Refer to Optional Starlog files on page 30. 

Using the test display 

PsiLog creates a display almost identical to that produced by the PC Starlog softw are 
package PDLFTU program.   How ever, as the Psion screen is much smaller than the 
PC screen, some scrolling is necessary.   The arrow  keys scroll the display.   By default, 
the arrow  keys by themselves w ill scroll by half the screen size, but if you hold dow n 
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the Ctrl key and press an arrow  key, the screen w ill scroll one character at a time.   
These settings can be adjusted.   See User interface preferences on page 39. 

See Address/Step size on page 74 for some other key presses. 

Other test displays 

PsiLog allow s you to open arbitrary test display files.   Such files include special 
diagnostic screens that Unidata provide w ith their Starlog softw are package to assist 
w ith troubleshooting.   PsiLog w ill copy these files from the Starlog softw are package 
as part of the Optional Starlog files (see page 30). 

To open a test display file make sure you are in the Test Display mode by pressing 
Shift-Psion-T then select Open screen from the File menu: 

 
In the dialog that appears, you can type the name of the file you w ant to open.   Press 
Tab to see a list of files. 

This function can be used to open any scheme test display too.   Press the Tab key to 
see the list of files.   Navigate to the directory w here the scheme files are stored (see 
Scheme preferences on page 42) and select the scheme test display you w ant to open. 

Logger functions 
PsiLog allow s you to perform the same data logger functions that the PC Starlog 
softw are supports. 

Initialise 
This function initialises the data logger.   It causes the data logger to re-read its 
configuration table and apply the settings.   If the data logger w as set to its ‘sleep’ 
mode, it w ill ‘w ake up’.   If the data logger is a Macro logger and the current 
configuration is found to be bad in some w ay, it w ill reload the factory default 
configuration and use that.   This may affect running schemes.   For non-Macro 
loggers w ith configuration tables, initialising the data logger w ill never affect running 
schemes. 

This has no effect on PDL data loggers and w ill fail w ith an error message. 
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Reset 
This function resets the data logger to use its factory default configuration.   This is 
only applicable to Macro loggers.   Using this option for non-Macro loggers w ith 
configuration tables is identical to the Initialise option above. 

This has no effect on PDL data loggers and w ill fail w ith an error message. 

Sleep 
This function w ill put the data logger to sleep.   It w ill also stop the scheme.   While 
asleep the data logger uses almost no pow er and does not perform any processing. 

This has no effect on PDL data loggers, and w ill fail w ith an error message. 

Force log 
This function only w orks for schemes generated by recent revisions of the Starlog 
Version 3 softw are, and then only those schemes that are ‘event based’.   See your 
Starlog softw are manual for more information. 

For those schemes that are compatible w ith this function, this w ill cause the scheme to 
perform a logging cycle on its next scan. 

You can use this function if you are on site and w ant to dow nload the very latest 
logged data (for example, force an average calculation to be logged). 

If the scheme is not event based, PsiLog w ill beep and display the message Force 
log: Scheme not event based. 

Correct time 
This function only w orks for schemes generated by recent revisions of the Starlog 
Version 3 softw are.   It w orks for all types of schemes: both ‘event based’ and ‘fixed 
log interval’. 

The effect of this function is either to cause schemes to execute tw ice per scan or to 
skip every other scan as appropriate in order for the time to be corrected.   In other 
w ords, the data logger time is corrected gradually over many scans. 

You can check the effect of this function by w atching the progress of the time 
reported by the data logger. 

IMPORTANT NOTE: This does not correct the memory card clock used by memory 
card data loggers.   To correct memory card clocks the data logger must be 
reprogrammed w ith a scheme. 
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Data functions 

These functions allow  you to send information to the data logger, possibly altering 
scheme parameters.   The use of these functions could impair scheme operation.   Use 
them w ith care. 

Address/Step size 
This function sets the current base address and address step size.   When the Test 
Display screen is displayed (no menus or dialogs) you can use Ctrl-PgUp/PgDn 
(Ctrl-Psion-Up Arrow and Ctrl-Psion-Down Arrow on a Workabout) 
to change the base address in increments of the step size.   As you change the base 
address this w ay, the new  base address value w ill appear briefly in the bottom right of 
the screen. 

This function only affects a few  specially designed Test Display screens.   Scheme test 
display screens are never affected by these options. 

Put 
This function allow s you to send data to arbitrary addresses in the data logger.   By 
default the Address field is the same as the current base address.   The Data field is 
w here you enter the information to send to the data logger.   The format of this field is 
explained in a later paragraph. 

Select the Put function from the Data menu: 

 

The Mode field is w here you specify how  the information is to be sent to the data 
logger.   The options are combinations of Put/Write and 
Standard/Extended.   Put/Write refers to the type of data logger memory to 
w rite to.   Put w rites into the data logger’s virtual memory, w hile Write w rites into 
the data logger’s real memory.   Refer to your data logger’s hardw are manual for more 
information.   Note that PDL data loggers do not have real memory; they only have 
virtual memory. 

Standard/Extended refers to how  the memory is address.   Standard 
addressing can only refer to the first 64K of that memory.   If you are using a data 



PsiLog  75 

logger that has more than 64K memory, and you are w riting into that extra memory 
beyond the first 64K, then you must use the Extended mode. 

 
Data field format 

The Data field can have one or more items, separated by commas.   The items can 
specify numeric and text data.   Text items are distinguished by starting w ith double-
quotes (").   Anything else and the items are assumed to be numeric. 

Text items start and end w ith double-quotes.   The data they represent is made up of 
the characters betw een (and not including) the double-quotes. 

Numeric items are numbers w ith some optional formatting characters.   Numeric fields 
may start w ith an optional size modifier coded as a single letter: 

•  B/b – The number is a byte integer (8 bits) (-128…255 allow ed) 
•  W/w  – The number is a w ord integer (16 bits) (-32768…65535 allow ed) 
•  D/d – The number is a double-w ord integer (32 bits) 

(-2147483648…4294967296 allow ed) 
•  F/f – The number is floating point (64 bits) 

If there is no size modifier, then the smallest size that fits the number w ill be used.   
For example, if the number is 500, it does not fit in a byte but it w ill fit in a w ord, so a 
w ord size w ill be used. 

Next, there may be an optional sign character, either ‘+’ or ‘-’, follow ed by the number 
itself. 

At the beginning of the number there may be an optional base modifier: 

•  If the number starts w ith ‘0X’ or ‘0x’ or a dollar sign (‘$’) or the letter ‘H/h’ it 
is assumed to be base 16 or hexadecimal.   Hexadecimal numbers allow  the 
character 0 to 9 as normal, but the letters A through F can also represent 
digits. 

•  If the number starts w ith a zero ‘0’ (but not ‘0x’) or the letter ‘O/o’ then it is 
assumed to be base 8 or octal.   Octal numbers only allow  the digits ‘0’ 
through ‘7’ inclusive. 

•  If the number starts w ith the letter ‘B/b’ then it is assumed to be base 2 or 
binary.   Binary numbers only allow  the digits ‘0’ and ‘1’. 

You can also have an optional base modifier at the end of the number: 

•  If the number ends w ith ‘H’ or ‘h’ it is assumed to be base 16 or hexadecimal. 

•  If the number ends w ith ‘D’ or ‘d’ it is assumed to be base 10 or decimal, 
except if the ‘0x’ or ‘$’ hexadecimal base modifier preceded the number.   In 
that case, the ‘D’ w ill be treated as a hexadecimal digit of the number. 
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•  If the number ends w ith ‘O’ or ‘o’ it is assumed to be base 8 or octal. 

•  If the number ends w ith ‘B’ or ‘b’ it is assumed to be base 2 or binary, except 
if the ‘0x’ or ‘$’ hexadecimal base modifier preceded the number.   In that 
case, the ‘B’ w ill be treated as a hexadecimal digit of the number. 

If there are no base modifiers, the default base 10 (decimal) is used.   Where there is a 
conflict of base modifiers not covered above, the modifier at the end of the number 
takes precedence. 

For example, to set the name of the scheme to ‘MYNAME’ the dialog w ould look like: 

 

You can enter ‘blank’ spaces by entering multiple commas.   Each extra comma causes 
a single byte of data logger memory to be skipped (not altered).   For example, ‘1,2,3’ 
causes the values ‘1’, ‘2’, and ‘3’ to be w ritten into three consecutive memory bytes.   
How ever, ‘1,,2’ causes ‘1’ to be w ritten into the first byte, the second byte is skipped 
(not changed) and ‘2’ is w ritten into the third byte.   Note that you can only skip bytes, 
trying something like ‘1,d,2’ w ill cause ‘1’ to be w ritten to the first byte, the next four 
bytes w ill be set to zero (the ‘d’ specifies a double-w ord or four-byte value), and ‘2’ will 
be w ritten to the sixth byte. 

Here is an example: 

 

Press Enter to accept the dialog and you should see a Put message appear in the 
bottom-left of the screen, follow ed by Put:OK briefly in the bottom-right.   If there is 
a problem putting, simply try again by repeating the procedure. 

Put entry 
This is very similar to the Put function above, except that it scans the data fields on the 
Test display screen for ones that are suitable to be w ritten to.   Suitable data fields are 
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placed into the Entry field.   Choose the data field you w ant to set from the list, and 
then enter the value into the Value field.   The number you enter is as you w ould like 
to see it on the Test display screen.   For example, if the data field is show ing 
temperature ‘degC’, then enter your value in ‘degC’.   If the data field is a string (for 
example, the scheme name), then enter the new  string w ithout double-quotes. 

 

Press Enter to accept the dialog and you should see a Put message appear in the 
bottom-left of the screen, follow ed by Put:OK briefly in the bottom-right.   If there is 
a problem putting, simply try again by repeating the procedure. 

Setup modem 
This function is not for use w ith data loggers, but for modems.   It uses the 
PDLMODEM.DAT file from Version 3.09A and later Starlog softw are to identify and 
initialise your modem.   See Transferring files from your PC on page 70. 

Modems are divided into tw o types: 

1. Local – These modems are connected to computers (for example, your PC 
or Psion) and are used to dial out to modems connected to data loggers. 

2. Remote – These modems are connected to data loggers and receive calls 
made from the modem connected to your computer. 

Connect your Psion to the modem (a null-modem cable may be required) and select 
either For local use or For remote use as appropriate. 

 

Press Enter to accept the dialog and configure the modem according to the settings 
in the PDLMODEM.DAT file.   If you see a message Could not open 
Pdlmodem.dat then you need to copy the file from your PC.   See Transferring files 
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from your PC on page 70.   If you do not have Version 3.09A or later softw are installed 
on your PC, then you w ill not be able to use this function of PsiLog. 

Preferences 

The Test Display preferences are used to balance memory consumption and 
communications throughput. 

To understand these preferences it is necessary to explain how  the Test Display reads 
information from the data logger. 

Each test display screen is usually displaying many different items, all from different 
parts of data logger memory.   On some screens, there could be many tens of items. 

To improve the speed of display, PsiLog does not read each display item individually 
from the data logger.   Instead, display items that are close together in data logger 
memory w ill be grouped and read in a single request.   For example, assume that there 
are tw enty, one-byte display items to be show n.   At 9600 baud, each byte w ill take 
about 20ms to send.   How ever, there is a fixed overhead of about five bytes (100ms).   
Reading them individually w ould take 20 × (20 + 100) = 2400ms.   If it w ere possible 
to group them into a single request, it w ould take only 20 × 20 + 100 = 500ms.   Note 
that modem communications can add nearly 1000ms to the overhead (or 22400ms vs. 
1500ms). 

When deciding how  to group display items, PsiLog must decide how  close is close 
enough for a display item to be added to a group.   This is called the Merge Threshold.   
If tw o display items are closer than the Merge Threshold they w ill be merged together. 

The dow nside to merging is w asted space betw een grouped items.   For example, if the 
Merge Threshold is 30, then in the w orst case there could be up to 29 bytes of un-
needed information being sent from the data logger.   Plus, the entire merged request 
is stored in PsiLog memory. 

 

•  Maximum size – This limits the size of items that can be requested from the 
data logger in a single group.   The display update rate can be improved by 
making this value bigger.   How ever, if the communications link is poor, you 
may achieve better results by using smaller values. 
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•  Merge threshold – This sets how  close in data logger memory display items 
have to be to be merged.   Setting it too high or too low  w ill reduce the speed 
of communications.   Setting it too high tends to w aste memory.   Depending 
on the Test display being view ed, and the quality of the communications link 
betw een the Psion and the data logger, adjusting this higher or low er may 
improve the speed of communications. 

•  Kill logger – This affects w hen the data logger is told to stop 
communications and w ait until the next scan.   In this context ‘killing’ the 
data logger does not affect the scheme or the data being logged. 
End of requests – The data logger is ‘killed’ after all the requests for a 
particular display screen have been made once.   The next time the data 
logger w akes up for communications, the requests w ill be sent again and the 
display updated.   This is the preferred option w hen the communication 
speed is fast and relatively error-free, or w hen the data logger is using 
moderate to slow  scan rates. 
Each request – The data logger is ‘killed’ after the data for each group 
of display items has been requested and received.   The next time the data 
logger w akes up for communications the Test Display w ill request data for 
the next group of data items.   This is the preferred option w hen the 
communication speed is slow  or suffers from errors, or w hen the data logger 
is using fast scan rates.   This is particularly important for old PDL data 
loggers, because if they are kept communicating for too long they w ill miss 
scans and lose time. 
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Velocity trace 

Introduction 

This mode only w orks w hen PsiLog is connected to a Model 6526 Starflow  data 
logger.   You select the Velocity Trace mode by pressing Shift-Psion-V.   It 
displays a spectrum of the velocities currently being seen by a Starflow  data logger and 
is the same as the UDITRACE program that is part of the Starlog softw are package on 
PC computers.   The graph of the velocity spectrum allow s you to judge if the Starflow 
is measuring velocity correctly. 

 
If you connect a data logger that is not a Model 6526 Starflow , you w ill see the 
“Logger is not a Starflow ”  message on the screen: 

 
By default, PsiLog has a communications buffer size of 8500.   If you have configured 
PsiLog to have a smaller communications buffer, you may see the follow ing message: 

 
You must increase the size of the communications buffer to the value show n (in the 
example above, 2100).   See Communications preferences on page 41. 
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Display 

The bulk of the Velocity Trace screen is devoted to the histogram of velocities.   
Above the graph are some readings from the Starflow .   Select the group of readings 
being displayed by pressing the left or right arrow  keys.   There are tw o groups: 

•  Med “median velocity” – This is the statistical median velocity out of those 
measured by the Starflow  during its most recent sampling.   This is the 
velocity recorded by the Starflow . 
Qtl “quartile” – This is a measurement of how  close all the velocity samples 
are to the median velocity.   The larger this value, the more spread out the 
velocities are. 
# “number of velocity samples” – This is the number of velocity samples 
taken by the Starflow .   The more samples, the better the velocity 
measurement. 
Avg “average velocity” – This the average of all the velocities measured by 
the Starflow  during its most recent sampling. 
Max “maximum velocity” – This is the largest velocity measured by the 
Starflow  during its most recent sampling. 

•  Scheme “scheme name” – This is the name of the scheme currently 
programmed in the Starflow . 
Depth “water depth” – This is the depth of w ater above the Starflow .   
Deeper w ater tends to produce better velocity measurements. 
Signal “signal strength” – This is a measure of the strength of the signals 
received by the Starflow .   The larger the number, the stronger the signal. 

Further reading 

Please refer to the manual that came w ith your Starflow .   It has an excellent chapter 
describing the use of the velocity trace data and covers the various types of histograms 
you might see and w hat they mean. 
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Communications window 

Introduction 

This mode, selected by pressing Shift-Psion-W, allow s you to communicate 
directly w ith your data logger or a modem as an aid to troubleshooting problems.   In 
particular, it allow s you to access a data logger’s diagnostic modes if the logger 
provides this function.   Some data loggers do not support a diagnostic mode. 

Note that different data loggers support different types of diagnostic modes.   Consult 
your data logger’s hardw are manual for more detailed information. 

Checking that your data logger is communicating 

When your data logger is connected to your Psion and everything is configured 
correctly, you w ill see a prompt from the data logger at regular intervals.   Each data 
logger prompt is an asterisk character (*).   Typically, data loggers send out prompts 
each time they scan (in other w ords, at the scan rate).   How ever, in some cases w hen 
the data logger has a scan rate longer than 15 seconds, prompts may appear every four 
seconds instead. 

The follow ing screen is an example of tw o data logger prompts and the cursor bar: 

 

The important thing is, if you can see prompts from the data logger, your 
communications configuration is correct.   If you don’t see any prompts, try different 
baud rates and ports by altering your Communications Preferences.   See 
Communications preferences on page 41 and Serial communications on page 88 for more 
information. 

If you can see prompts, then you know  the link from the data logger to the computer 
is w orking.   To test the link from the computer to the data logger, send lots of 
uppercase G’s to the data logger.   Do not send low ercase g’s.  They w ill make the data 
logger send a lot of information and prevent it from communicating for the duration 
(about 68sec at the default 9600 baud rate). 
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Press and hold dow n the key (Shift-G) to do this.   You should see lots of capital 
G’s on the screen.   You may need to hold the key dow n for 15-20 seconds. 

 

If the data logger is receiving, then it w ill respond w ith some numbers and letters. 

 

If you see something like that (the exact letters aren’t important, so long as you can see 
numbers and/or letters), then you can be confident that the communications betw een 
your Psion and your data logger is w orking correctly. 

If you don’t get any response from the data logger, but you did see prompts earlier on, 
then there must be a break in the link betw een the computer and the data logger.   Try 
a different cable, or if you know  how , check the continuity of the w ires from 
connector to connector.   See Serial connections on page 9 and Serial communications on 
page 88 for more information. 
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Logger diagnostics 

The communications w indow  is also used to gain access to the data logger’s diagnostic 
modes.   Assuming that the communications betw een your computer and data logger 
is w orking, make sure you are in the Communications Window  mode by pressing 
Shift-Psion-W then select Diagnostics from the Communications 
menu: 

 

PsiLog w ill then tell the data logger to enter diagnostics mode.   What you w ill see w ill 
depend on the model of the data logger you have connected.   Some data loggers don’t 
have a diagnostic mode, in w hich case you w ill probably see a Timeout message.   
Note that you might have to zoom to the smallest font (Psion-Z) and hide the 
status w indow  (Ctrl-Menu) before the diagnostics menu w ill display properly. 

Below  is w hat the diagnostic mode of a Model 6004B Starlogger looks like: 

 

The usual command to exit diagnostic mode is K.   Refer to your data logger’s 
hardw are manual for more information about its diagnostic modes. 

Modem control 

You can also use the communications w indow  to send commands to a modem.   This 
can be useful to check and set the configuration, or to manually dial or answ er calls.   
See your modem’s manual for the commands that it understands. 

See also Modem on page 45. 
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Preferences 

The Communications w indow  preferences allow  you to adjust the operation of the 
Communications Window . 

 

•  Refresh rate – This affects how  quickly PsiLog updates the display as 
characters are received through the serial port.   PsiLog is quite slow  w hen it 
comes to draw ing on the screen, so instead of draw ing every character as it is 
received, PsiLog w ill w ait for the time specified by this preference before 
draw ing a batch of letters at once. 

•  Local echo – If this is On then every letter you type w ill be echoed to the 
screen as you type it.   If this is Off the letters are not echoed.   Often 
modems are configured to echo characters back to you as you type them.   If 
both the modem and PsiLog are echoing, you w ill see ‘double’ as each time 
you type a letter it w ill appear tw ice on the screen.   Either turn this 
preference Off or consult your modem’s manual to configure the modem 
not to echo.   Normally, this preference should be left On. 
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Troubleshooting 
 
 
 
 
 

Serial communications 
Running PsiLog 
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Serial communications 

Background 

In any application that uses serial communications, the serial communications link is 
w here most problems arise.   This is due to so many variables being involved.   Usually 
there are multiple serial ports on the computer, sometimes w ith different sockets.   
The configuration of the serial port (baud rate, stop bits, and parity) can also vary.   
Depending on the equipment, even identical sockets w ith identical configurations 
cannot talk to each other because of differences in the pin configurations on the plugs 
and/or sockets! 

The solution to these problems comes from understanding w here the problems could 
arise.   The follow ing section contains information to assist in understanding and 
troubleshooting serial communications. 

How serial communications works 
See also Serial connections on page 9 for information on cables to use w ith Workabout 
computers. 

Connectors 
On IBM compatible PCs, the physical serial plugs can be of tw o types.   They are DB9 
and DB25.   The numbers refer to the number of pins used.   The former has one row 
of 5 pins and one row  of 4 pins; the latter has one row  of 13 pins and one row  of 12 
pins. 

There are likely to be other similar sockets on the back of the computer.   These may 
have the same shape, but have holes instead of pins.   The one w ith 25 pins (called a 
DB25 socket) is usually a parallel port used for connecting to printers.   The one w ith 15 
pins in tw o row s of 8 and 7 (DB15 socket) is your computer’s games port, used for 
connecting a joystick, gamepad or steering w heel.   Another 15-pin socket in three 
row s of five pins each is your video port, used to connect to your monitor.   Older 
computers may use a DB9 socket as their video connector.   If you don’t see them it’s 
probably OK.   They are not relevant to serial communications. 
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The diagram below  show s some plugs and sockets: 

Plugs/Sockets on Computers/Cables 

DB25 plug 
Computer serial port & 
data logger end of cable 

DB9 plug 
Computer serial port, Workabout RS-232 serial port 

   

DB25 socket 
Computer parallel port, 

computer end of serial cable & 
data logger serial connector 

DB9 socket 
Computer end of serial cable, Workabout TTL serial 

port & data logger serial connector 

   

Wiring (Cable) 
Serial ports are w ired in one of tw o w ays: DTE or Data Terminal Equipment and DCE 
or Data Circuit-terminating Equipment.   An example of a DTE is your PC.   Examples of 
DCEs are data loggers and modems.   The connectors are w ired in such a w ay as to 
allow  a DTE to be connected to a DCE via a straight-through  cable.   In other words, pin 
1 on the DTE connects to pin 1 on the DCE, pin 2 to pin 2, and so on.   Of course, 
this only makes sense w hen connectors w ith identical numbers of pins are used. 

A typical situation is to have tw o computers connected via tw o modems.   Each 
computer connects to its modem via a straight-through cable.   The modem devices 
are connected via the telephone netw ork. 

There may be a situation w hen tw o computers need to be connected together w ithout 
any modems devices in betw een.   For example, it w ould be unusual to connect tw o 
computers sitting right next to each other via modems and the telephone netw ork.   
The problem is that a computer is designed to connect to a modem and not another 
computer.   The reason is that the w ire (call it X) that transmits data from the 
computer connects via a straight-through cable to the modem w ire (X) that receives 
the data.   In other w ords, if pin X on a computer transmits, then pin X on a modem 
receives.   If tw o computers w ere connected to each other then their transmit w ires 
(both X) w ould be connected together! 

The solution is a small device called a null-modem.   It has tw o sockets that the cables 
from each of the computers connect to.   The w iring inside the null-modem fakes the 
presence of real modems by crossing over the receive and transmit w ires (among 
others), allow ing the tw o computers to talk to each other.   Sometimes the null-modem 
comes in the form of a special cable, called a null-modem cable that plugs directly into the 
tw o computers’ serial ports. 
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Follow ing is a table show ing the pins used for RS-232 serial communications from a 
DTE point of view : 

DB25 DB9 Description Direction (DTE↔DCE) 
2 3 TxD: transmit → 
3 2 RxD: receive ← 
4 7 RTS: request to send → 
5 8 CTS: clear to send ← 
6 6 DSR: data set ready ← 
7 5 GND: signal ground – 
8 1 CD: carrier detect ← 

20 4 DTR: data terminal ready → 
22 9 RI: ring indicator ← 

Note that only 9 pins out of the 25 pins on a DB25 connector are listed above.   
Computers do not use those other 14 pins for RS-232 communications.   How ever, 
Unidata data loggers have uses for some of the pins.   See your data logger hardw are 
manual for more information. 

When connecting tw o serial devices, you must know  if they are DTE or DCE devices.   
If they are different (DTE and DCE), then you can use a straight-through cable to 
connect them.   If they are the same (DTE and DTE or DCE and DCE), then you 
must use a null-modem (either device or cable) to connect them.   Note that a 
DTE↔DTE null modem is different from a DCE↔DCE null modem. 

To communicate w ith Unidata data loggers, you need to use a minimum of four w ires: 
TxD, RxD, GND, and RTS.   If you are not using the default baud rate, you may need 
to use some other pins to set the required baud rate.   See your data logger hardw are 
manual for more information. 

Follow ing are some sample cable connections: 

Computer DB25 to Data Logger DB25: 2 to 2, 3 to 3, 4 to 4, and 7 to 7. 

Computer/Workabout DB9 to Data Logger DB25: 3 to 2, 2 to 3, 7 to 4, and 5 to 7. 

Psion DB25 to Data Logger DB25: 3 to 2, 2 to 3, 6 to 4, and 7 to 7. 

Configuration 
Having all the pins connected properly w ill still not ensure your tw o devices w ill talk to 
each other! 

To ensure all the bits are sent and received in an orderly fashion they must be sent at a 
speed agreed to by both devices.   This speed is called the baud rate and represents the 
number of bits transmitted/received each second.   If the tw o devices use different 
baud rates, they w ill not be able to communicate.   Just about any agreed value is 
possible for a baud rate, but Unidata data loggers only support the follow ing values: 
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300, 1200, 2400, 4800, 9600, 19200 and 38400.   They also support a baud rate of 
76800, but this is not supported by computers and can be ignored.   The usual baud 
rate used by Unidata data loggers is 9600. 

The tw o devices also have to agree on the number of data bits to use, the number of 
stop bits to use, and the type of parity.   Again, unless these are the same for both 
devices, communication w ill not be able to take place.   Possible data bit values are: 5, 
6, 7, and 8.   Possible stop bit values are 1, 1½, and 2.   Possible parity values are: 
None, Even, Odd, Mark, and Space.   All Unidata data loggers ship w ith a 
configuration of 8 data bits, 1 stop bit, and no parity.   It is almost unheard of for a 
data logger to have a different configuration.   Some data loggers do not even allow  
these settings to be altered!   An incorrect configuration of these settings should only 
be considered after all other options have been exhausted. 

How to troubleshoot 

To get serial communications w orking, first determine the things you do know .   For 
example, you might already know  w hich serial port connector on your computer is the 
correct one to use.   In that case, only the w iring (cable) and/or configuration could be 
causing problems. 

Often it is easy to eliminate some of the more obvious areas of trouble.   If you can 
configure the softw are at both ends of the serial communications to the exact same 
settings, then all that remains is the connector and/or the w iring (cable).   For 
example, it is safe to assume that all data loggers w ill be using 8 data bits, 1 stop bit 
and no parity.   In fact, the PsiLog and Unidata Starlog softw are packages w ill alw ays 
use these settings and not allow  you to use any other!   That leaves the baud rate as the 
only configuration variable. 

Finding the connector 
The data logger is easy – it has just the one connector.   Your computer, how ever, 
probably has several connectors.   Look for the 25 and 9 pin connectors w ith the pins 
visible, and not the ones w ith the holes. 

All computers support more than one serial port.   To distinguish betw een them they 
are called different names.   The first port is called COM1 the second COM2 and so 
on.   Unless your port connectors are labelled, it is quite difficult to determine w hich 
serial port connector is w hich. 

If you have a data logger, you can connect it using a serial cable suitable for connecting 
a modem to your computer.   Make sure the data logger is aw ake and scanning.   Run 
the Starlog softw are, go into the test display and open a Communications Window .   If 
the data logger is connected to the same port the softw are is using, then some serial 
data w ill appear on the screen every time the data logger scans.   The serial data can 
look different depending on the baud rate, but it w ill look the same each time and 
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appear at regular intervals.   If you happen to have the correct baud rate, it w ill look 
like an asterisk (*).   If nothing appears on the screen, select a different port and try 
again.   If you have different port connectors, change to a different connector, then try 
all the ports in the softw are again.   See also Checking that your data logger is communicating 
on page 82. 

You could also use a special device called a breakout box or mini-tester.   These devices 
connect LEDs (lights) to the various communications signals.   By connecting one of 
these devices to a serial port and using a communications program to select each COM 
port in turn, you’ll be able to tell w hich COM port is named w hat by seeing w hen the 
lights change. 

The Psion Workabout computer can vary from model to model, but most likely the 
serial port on the top right is the correct one.   It w ill be called TTY:A.   If you are 
unsure, consult the manual that came w ith your Psion.   It must have an RS-232 level 
serial port.   Serial ports using TTL levels are not suitable for communicating w ith 
either data loggers or your PC. 

Wiring (Cable)  
Troubleshooting the w iring is not possible w ithout a multimeter or a continuity tester.   
With these devices you can check that the pins on either end of the cable are correctly 
connected together.   Each pin or socket on each connector has a tiny number next to 
it.   Use these numbers and the description under How serial communications works on 
page 88 to check your cables. 

If you don’t have any testing equipment, then the only thing is to try a different cable.   
If you have an external modem it might have come w ith a serial cable of its ow n – try 
that one.   Sometimes computer mice come w ith a small adapter – using that could 
help.   See Serial connections on page 9 for descriptions and photos of cables suitable for 
Workabout computers. 

Configuration 
The configuration requirements for communicating w ith data loggers are quite simple: 
8 data bits, 1 stop bit, and no parity.   The serial link betw een your Psion and your PC 
is the same. 

The only variable configuration item is the baud rate.   This must be set to exactly the 
same value for both ends of the communication.   A typical baud rate for a data logger 
is 9600. 

If everything fails 

If all else fails, perhaps you should check for something simple, like a flat battery in the 
data logger! 
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Running PsiLog 

Background 

This section assumes you have installed PsiLog by follow ing the instructions under 
Installing PsiLog on page 14. 

The rest of this section describes the problems you might encounter w hen running 
PsiLog. 

Required files 

PsiLog requires at minimum three files: a startup program file, the application program 
file and a resource file. 

The startup file is called PSILOG.OPO and is stored in a directory called \OPO on 
any local disk (Internal, A, or B) on your Psion.   It exists to let you start PsiLog 
via the “Run OPL” icon of the System screen: 

 
If you have configured PsiLog to autostart (see User interface preferences on page 39), then 
simply pressing Enter at the Workabout startup screen w ill start PsiLog: 
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The application program file is alw ays called PSILOG.OPA and must be in a directory 
called \APP on any local disk (Internal, A, or B) on your Psion.   If you have 
somehow  deleted PSILOG.OPA, but PsiLog is still listed under the “Run OPL” icon 
on the System screen, you w ill get the follow ing w hen you try to run PsiLog: 

 

You must reinstall PsiLog.   Follow  the instructions under Installing PsiLog on page 14.   
Reinstallation of PsiLog w ill not affect any existing unload files, scheme files, or 
PsiLog settings. 

The resource file can have a variety of names: either PSILOG.RSC or PSILOG.~xx 
w here xx is a tw o-digit number representing a country code.   The standard PsiLog 
program distributed by SCSS comes w ith PSILOG.~20.   In all cases, the resource 
file is alw ays stored in a directory called \APP\PSILOG on a local disk (Internal, 
A, or B) on your Psion. 

If PsiLog cannot find a suitable resource file, you w ill get the follow ing w hen you try 
to run PsiLog: 

 

You must reinstall PsiLog.   Follow  the instructions under Installing PsiLog on page 14. 

Required memory 

After PsiLog has been installed, PsiLog requires more memory to run.   The follow ing 
table lists some example PsiLog functions and the memory they require.   It does not 
include any disk space some of these functions may also require, such as storage for 
formula files: 

 
 



PsiLog  95 

Function Memory Required 
Startup 46K 

Formulas 6K 
View ing online help 4K 

View ing logger test display 6K 

The Startup figure given above includes a default 8K cache and 8½K communications 
buffer.   The memory used by these is set via preferences.   See User interface preferences 
on page 39 and Communications preferences on page 41. 

If PsiLog does run out of memory, you w ill probably see the follow ing:  

 

PsiLog may not even have enough memory to handle your keypresses – not even to 
exit or adjust your preferences!   If this is the case, you w ill have no option but to force 
PsiLog to exit.   Press Ctrl-Shift-Psion-K.   PsiLog w ill immediately exit.   
Any changes you made to preferences since you started PsiLog may be lost.   All your 
unloaded data w ill be safe, except for data you might have been in the process of 
unloading w hen you forced PsiLog to exit. 

If you get this message immediately you start PsiLog, one or more of the follow ing 
three possibilities w ill cause it: 

1. You are running other programs that have taken up a lot of memory.   Exit some of 
them to free up memory. 

2. You have a lot of data stored on the Internal disk on your Psion.   Either move 
some of the data to a SSD, transfer some to your PC, or delete some.   See 
Unnecessary PsiLog files below . 

3. The PsiLog cache and communications buffer settings are too big.   See Resetting 
PsiLog preferences below . 

Unnecessary PsiLog files 

If you are running short of disk space or memory, you can safely delete some files used 
by PsiLog.   Refer to the table below : 
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Name Directory 

(on any local disk: 
Internal, A or B) 

Consequence 

PDLOUT.FOR 
PDLOUT.TXT 

\APP\PSILOG Formulas not available – some test 
display screens may not load 

PDLFTU.DB 
*.FTU 

\APP\PSILOG Logger test display function will 
not work 

PDLMODEM.DAT \APP\PSILOG Setup modem function will not 
work 

Schemename.CDT, 
.CFG, .ENT, .FTU, 
.INI, .KBD, .LDR 

\STARLOG 
(default – see Scheme 
preferences on page 42) 

Scheme not available to program 
logger.   Scheme test display not 
available for loggers programmed 
with the scheme.   Data viewer not 
available for scheme. 

Schemename.U?? \STARLOG 
(default – see Scheme 
preferences on page 42) 

Unload data not available to 
transfer to PC or for viewing.   
Deleting unload files is only 
recommended as a last resort. 

Schemename.IUP \STARLOG 
(default – see Scheme 
preferences on page 42) 

First incremental unload of a 
scheme will be a full unload.   
Scheme incremental unload 
pointers not available for 
synchronisation with PC. 

You can safely delete these files, but be sure you understand the consequences.   To 
restore the files that w ere stored in the \APP\PSILOG directory, follow  the 
instructions under Optional Starlog files on page 30.   To restore the scheme files, follow 
the instructions under Transferring schemes from your PC on page 48.   To restore unload 
files, you w ill have to unload the data logger again. 

See Deleting a scheme on page 51 and Deleting unloads on page 56 for details on deleting 
scheme files and unload files. 

Resetting PsiLog preferences 

The only w ay to reset PsiLog preferences is to delete the PSILOG.INI file in the 
\OPD directory.   The directory is most likely on the Internal disk, but could also 
be on the other local disks A or B. 

The next time you start PsiLog after deleting PSILOG.INI, PsiLog w ill create a new 
PSILOG.INI file w ith all the settings reset to their defaults. 
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Glossary 
 

Baud rate – Technically, the number of times per second a signal can change state.   
Often used interchangeably w ith bit rate.   How ever, modern modems are able to 
send multiple bits per signal change and hence their bit rates are higher than their baud 
rates. 

Bit – A single binary digit, represented as a zero (0) or a one (1). 

Bit rate – The number of bits transmitted or received per second. 

Byte – A group of eight bits. 

Circular buffer – A buffer that the logger w ill store data in that allow s the oldest data 
to be overw ritten by new er data w hen it fills up.   Compare linear buffer. 
Data logger – Device that records data for later retrieval.   The units manufactured by 
Unidata include the ability to measure the data they record. 

Flash – A type of memory that does not need to be pow ered to retain its stored 
information.   Often, data can be stored for up to ten years w ithout loss.   Once 
w ritten, how ever, the data cannot be erased w ithout erasing the entire device. 

FTU – Field Test Unit.   Originally, a handheld computer that performed a function 
similar to PsiLog and the Workabout.   Now  refers to the Test Display function of the 
Starlog and PsiLog softw are packages. 

KB – Kilobyte.   1024 bytes. 

Kill – Tell the data logger to stop communicating for the rest of this scan.   Does not 
affect the scheme or the data being logged. 

LED – Light Emitting Diode.   A small and pow er efficient light used by data loggers 
and other electronic devices.   Often coloured red or green, but yellow , blue and w hite 
are also possible. 

Level converter – A device that can translate betw een tw o devices that use different 
electrical signal levels and w ould otherw ise be unable to communicate. 

Linear buffer – A buffer that the logger w ill store data in until it is full, thereafter 
refusing to log more data.   Compare circular buffer. 
Log interval – The time betw een successive logs. 

MB – Megabyte.   1048576 bytes. 

Modem – Modulator-Demodulator.   A device that connects digital computers to the 
analogue telephone netw ork. 
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PC – Personal Computer.   Usually the main computer you w ould use.   It w ould 
typically run such programs as Window s and Starlog softw are. 

PDL – Portable Data Logger.   The original data logger manufactured by Unidata 
Australia. 

Port – A plug or socket that allow s cables to be connected to the computer. 

Prompt – A special character (an asterisk ‘*’) sent by the data logger w henever it is 
ready to communicate.   This is usually, but not alw ays, w henever the logger pow ers up 
to record its inputs. 

RAM – Random Access Memory.   A type of memory that must be constantly 
pow ered or else it forgets everything stored inside it.   In environments w here the 
pow er supply is not guaranteed, this memory w ill often have a backup battery to keep 
it pow ered in case its main pow er supply fails. 

RS-232 Level – RS-232 level signals represent the binary digits 0 as +3…+12v and 1 
as –12…-3v.   See also TTL Level. 
Scan – When a data logger pow ers up to measure its inputs.   Each scan is generally of 
brief duration, usually less than 50ms.   The scan is also typically w hen a data logger is 
able to communicate w ith a computer.   When a computer is connected, the logger can 
w ait for up to 1second to allow  the communications link to be established. 

Scan interval/rate – A reference to the frequency w ith w hich a data logger powers up 
to perform a scan. 

Scheme – A program that tells Unidata data loggers w hat to record and w hen. 

Serial – In terms of communications, the method by w hich binary digits are sent one 
at a time.   The sending more than one bit at a time is called parallel.   Also used to 
associate other devices w ith this type of communication, hence serial cable and serial port.   
In general, ten bits need to be transmitted for every eight bits (one byte) of data. 

Sleep – A special low  pow er mode w here the data logger is not expending pow er 
scanning its inputs or trying to communicate. 

SSD – Solid State Disk.   A type of removable storage used by Psions.   SSDs are small 
cartridges containing electronic circuits that are used to store large amounts of data.   
They come in tw o types: RAM and Flash. 

TTL Level - Transistor-Transistor Logic.   TTL level signals represent the binary 
digits 0 as 0v and 1 as 5v.   See also RS-232 Level. 
UDI - Ultrasonic Doppler Instrument.   Another name for the Starflow  data logger. 

Unload - To read recorded information out of your data logger. 
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Data view er..............................................59 
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Emergency exit .............................8, 95 
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